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won't see the toolbar’s shortcut menu. When you're finished making changes to the
toolbar, lock the taskbar again if you wish.)

Tip: How much horizontal taskbar space a toolbar consumes is up to you. Drag the perforated borderat
the left edge of a toolbar to make it wideror narrower. That's a good pointto remember #f, in fact, you can’t
find a blank spotto right-click.   
The resulting shortcut menu offers these choices:

* View lets you change thesize of the icons on the toolbar.

 
° Open Folder works only with the Quick Launch and Links toolbars (or toolbars

you've created yourself}. It opens a window thatlists what’s in the toolbar, so that
you can delete or rename theicons. (Of course, you can also delete or rename any
icon on these toolbars by right-clicking it and choosing Delete or Rename from
the shortcut menu. But the Open Folder commandis a better bet when you're
performing more extensive surgery on the toolbar, since you're able to work in a
window that isn’t nearly as claustrophobic as the toolbaritself.)

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

* Show Text identifies each toolbar icon with a text label.

* Show Title makes the toolbar’s name (such as “Quick Launch”or “Desktop”) ap-
pear on thetoolbar.

* Close Toolbar makes the toolbar disappear.

+ Always on Top and Auto-Hide appear on a toolbar’s shortcut menu only when
you've detached the toolbar, turning it into a floating palette as described in the
next section. They make any toolbar asflexible as the taskbar, at least when it comes
to hiding itself on cue.

Ifyou turn on Always on Top, then document windows cart cover up your toolbar.
And if you turn on Auto-Hide, a toclbar that you've attached to one edge of your
screen hides almost completely, until you point to it with your cursor,
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Moving toolbars
You don’t need to keep toolbars on the taskbar; you can move them to any spot on
the screen that you find handy, as shown in Figure 2-18. (The taskbar mustfirst be
unlocked,as described on page 96.) To return the toolbar toits original location, drag
its title bar back onto the taskbar.

 
 
 

 
 
 
 

 

Figure 2-18:

To park a toolbarin a different location, drag upward on
the “perforated”handle attheleft edge (top). The result is a
strange sort of floating toolbar (bottom); it’s now an onscreen,
perpetually available launcher. (Use tooltips, or choose Show
Text from its shortcut menu, to identify the icons.) Ifyou drag
the toolbar to an edge of the screen, if glues itself there like a
second taskbar.

 
 
Creating teelibars
The Quick Launch area of the taskbar is such a delightthat you may actually develop
a syndromecalled Quick Launch Envy—you'll find that havingonly oneisn’t enough.
You might wish to create several different Quick Launch toolbars, each stocked with

the iconsfor a different project or person. One could contain iconsforall the chapters
of a book you're writing; another could list only your games.

Fortunately, it’s easy to create as manydifferent custom toolbars as you like, each of
- which behaves exactly like the Quick Launchtoolbar.

Theshort way
Windows XP creates toolbars from folders; so before creating a toolbar of your own,
you must create a folder (unless you already havea folder that’s filled with the stuff
youwant to toolbarize).
Here’s the easiest way to turn a folderinto a toolbar:Just drag the folder icon until your
ctirsorstrikes the edge of your monitor (any edge except the one wherethe taskbar
is):‘When youlet go, you'll see a brand-new toolbar whose buttonslist the contents of
theffolder you just dragged. From here,it behaves justlike any other toolbar. You can
right-click itto make the icons smaller, you can drag it into the center of the screen
to.make it a floating palette, and so on. 
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The long way
The drag-and-drop methodis new to Windows XP, The old wayis still around, how-
ever, forpeople whobill by the hour.

To begin, right-click a blank spot on the taskbar. From the shortcut menu, choose
Toolbars—+New Toolbar to open the New Toolbar dialog box, as shown in Figure 2-
19. Find and click the folder you want, and thenclick OK.
  

Figere 2-19:
The majorfolders ofyour computer are displayedin the
New Toolbar dialog box, Click the + sign to expand a disk
or folder~and continue to expand disks and folders—until
you find the folder you're seeking. Or you can create a
new folder for your toolbar anywhere on the hard drive.

 
 

My Corputer
My Network Places
Recycle Bin
Notes to Self  

   
Your new toolbaris on the taskbar. Feel free to tailor it as described in the previous
discussions—by changingits icon sizes, hiding or showing the icon labels, or adding
new iconsto it by dragging them from other desktop windows.
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‘| very disk, folder,file, application, printer, and networked computer is repre-
i sented on your screen by an icon. To avoid spraying your screen with thou-
dsands of overlapping icons seething like snakes in a pit, Windows organizes

icons into folders, puts those folders into other folders, and so on.

 
This folder-in-a-folder-in-a-folder scheme worksbeautifully at reducing screen clut-
ter, but it means that you've got some hunting to do whenever you want to open a
particular icon.

Helping you navigate and manage yourfiles, folders, and disks with less stress and
greater speed was oneof the primary design goals of Windows—andofthis chap-
ter.
 

Tip: To create a new folder to hold your icons, right-click where you want the foider to appear (on the
desktop, or in any desktop window except My Computer), and choose New—Folder from the shortcut
menu. The new folder appears with is temporary “New Folder” namehighlighted. Type a new namefor
the folder and then press Enter, 
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The Folders of Windows XP

Thetop-level, all-encompassing, mother-ship window ofyour PC is the My Computer
window. From within this window,you have access to every disk, folder, and file on
your computer. Its slogan might well be: “If it’s notin here, it’s not on your PC”

To see it, choose Start—+My Computer, or double-click its icon on the desktop,if
you've putit there (page 22). (Andifit is on your desktop, remember that you can
renameit somethingthat’s a little more, well, dignified,by clicking it and then press-
ing the F2 key.)

No matter how you open the My Computer window (Figure 3-1), you generally see
several categories of icons:
 

Figure 3-1:
Top: The (My Computer window,
shown here en a corporate-
network PC, is the starting point
for any folder-digging you want
to do. It shows the disk drives af
your PC. if you double-click the
icon ofa removabie-disk drive

(like your CD-ROM drive, Zip
drive, or Jaz drive), you receive
only an error message unless
there's actually a disk in the drive.
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Bottom: The My Computer win-
dow on a workgroup computer
{thatfs, notpart ofa corporate
domain network) includes aifthe
perks included on a network com-
puter with the added advantage
ofthe “Files on This Computer”
category.

Systerm Tasks,
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Hard Disk Drives. These icons, of course, represent your PC’s hard drive (or drives,
ifyou've installed or attached additional ones). Most people, mostofthe time, are
most concerned with the Local Disk (C:), which represents the internal hard drive
preinstalled in your computer, (You're welcome to renamethis icon, by the way,
just as you would any icon.)

* Files on This Computer. This category appears only ifyour computer is a member
of a workgroup, notif it’s part of a domain network (see page 19). These folders,
which bear the names of people with accounts on that PC (page 513), store links
to all files and preferences for each person.

» Devices with Removable Storage. Here, Windowsis talking about your floppy
drive, CD or DVD drive, Zip drive, USB flash drive, and so on.
 

Tip: Ordinarily, ifyour name is, say, Chris, youre notallowed to open the Frank's Documenis folder;if you've
been given a Limited XP account (page 517), then double-clickingit produces only an error message. That's
the Windows XP security system at work.

But My Computeralso contains a foldercalled Shared Documents. This folderis like the community bulletin
board,in that everybody whouses this PC is free to deposit things, takethings out, and read whateverresides
there. See Chapter 20 for details. 

> Scanners and Cameras, This is where you see the iconsfor any digital cameras or
scanners you've installed.

° Other. You mayalso see a Control Panel icon here—if,for example, you addedit
as directed on page 87.

What's in the Local Disk (C:) Windew
You might be surprised to learn that your main hard drive window doesn’t actually
contain anything muchthat’s useful to you, the PC’s human companion.It’s organized
primarily for Windows’ own benefit.

If you double-click the Local Disk C: icon in My Computer—thatis, your primary
hard drive’s icon—a direly worded messagelets you know thatthesefiles are hidden.
“This folder contains files that keep your system working properly,’ it says. “You should
not modify its contents.” (Figure 3-2 shows a similar message.)

All of this important-sounding proseis aimed at the kind of person who,before the
invention ofthis warning message, fearlessly or naively cruised through the important
system files of their PCs, deleting and movingfiles until the computer was inoperable
{and then calling Microsoft for tech support).

‘Truth is, the C: drive also containsa lot of stuff that doesn’t belong to Windows—in-
cluding yourfiles. So when you're just looking (but not touching) the Windowssys-
tem files, or when you wantto burrow aroundin your own folders, it’s perfectly OK
to click the “Show the contents of this folder”link. Suddenly the C: drive’s formerly
invisible contents appear. They include these standard folders:
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Decuments and Settings
Windows XP has been designed from the ground up for computer sharing. Is ideal
for any situation where different family members, students, or workers share the
same machine.

In fact, in Windows XP, each person whouses the computer will tarn on the machine
to find his own securesetoffiles, folders, desktop pictures, Web bookmarks,fontcol-
lections, and preference settings. (Secure,at least, from other people who don’t have
administrative accounts. Much more about this feature in Chapter 17.)

Like it or not, Windows considers you one of these people. If you're the only one
who uses this PC, fine—you can simply ignore the sharing features. But in its little
software head, Windows XP still considers you an account holder, and stands ready
to accommodate any others who should come along.

In any case, now you should see the importance ofthe DocumentsandSettingsfolder.
Inside are folders namedforthe different people who use this PC. In general, Limited
account holders (page 517) aren’t allowed to open anybodyelse’sfolder.

Ifyoure the sole proprietor ofthe machine, there's only one accountfolder here—and
it’s named for you, of course. If not, there’s a folder here for each person who has
an account on this PC. (As noted above, if your PC isn’t part of a corporate domain
network,icons for these folders also appear in the My Computer window. Those are
only pointers to the real folders, which are here in Documents and Settings.)

Thisis only the first ofmany examples in which Windowsimposesa fairly rigid folder
structure, but this approach has its advantages. By keeping such tight control over
whichfiles go where, Windows XP keepsitself pure—and very stable, Furthermore,
Keeping all of your stuff in a single folder will make it very easy to back up your
work.

Program Files
This folder containsall of your applications—Word, Excel, Internet Explorer, your
games, and so on. But that isn’t the impression you get when you first open the folder
(Figure 3-2).

Fortunately, making them appear on your screen is easy enough: Simply click the
words “Show the contents of this folder.” They appear just below the “These files
are hidden” message, and also in the task pane. {The Local Disk (C:) drive window
works the same way.)

This peculiar behavior requires some explanation. AWindowsprogram istrta single,
self-contained icon. Instead, each is accompanied by a phalanx of supportfiles and
folders like the ones shown in Figure 3-2. Nestled amongall of these auxiliary files
is the actual application icon, which can’t even run ifit’s separated from its support
group.

As mentioned previously, Microsoft and other software companies grew weary of
taking tech-support cails from people whose programs stopped working after being
moved around.Finally, as a preemptive strike, Microsoft simply made them invis-
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ible. The “Thesefiles are hidden” message is meantto say: “Nothingto see here,folks.
Move along.”  
So howare you supposed to launch your programsif you can’t see them in the Pro-
gram Files folder? Just take your pick of a half-dozen ways, all of which are described
in the beginning of Chapter5. 

 

Figuira 3-2:
Top: The C: drive and
the Program Files folder
maystart out looking
empty.

Bottom: Here’s what
Microsoft Word

actually looks like~75
little software crumbs in

your Program Files—>
iicrosoft Office OF

ficeié folder. Only one
of these icons (the one
called WINWORD) is
ihe actual program. But
don’t iry fo move if, or
any ofits support files,
out of this folder. (It’s
OK, however, and even
encouraged. to drag
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Windows or WINNT

Here’s anotherfolder that Microsoft wishes its customers would simply ignore. This
most hallowed folder contains Windowsitself, the thousandsoflittle files that make
Windows, well, Windows. Most of these folders and files have cryptic names that
appeal to cryptic people.

Afofe: This folder is usually called Windows; however, it's called WINNTif you upgraded your cperating
system from Windows 2000. In the remaining pages af this book,let the term “Windows falder” refer to
“the folder called Windows or WINNT, Gepending on whether or not you upgraded your machine from
Windows 2000,"
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In general, the heaithiest PC is one whose Windowsfolder has been left alone. (One
exception: The Fonts folder contains the icons that represent the various typefaces
installed on your machine. You're free to add or remove iconsfrom this folder.)

 
Your Account Folder

Everything that makes your Windows XP experience your own sits inside the Local
Disk (C:) Documents and Settings|Your Name] folder. This is where Windows
stores your preferences, documents, pictures and music, Web favorites and cookies
(described below), and so on.

 
In general, you won't have much business interacting directly with this folder, except
perhaps to back it up. But understanding how Windows works—and how it keeps
yourstuff separate from that of everybody else whouses the machine-—is mucheasier
once you've had a tour of your own accountfolder.  

* Cookies. A cookie is a small (and controversial) preference file that some Web sites
deposit on your hard drive. This special file is how sites recognize you when you
visit them again. A cookie is responsible for the “Hello, [Your Name]!” message
that greets you when visiting Amazon.com, for example. Windows keeps them in
thas folder.

* Desktop. When you drag an icon out of a folder or disk window and onto your
Windows XP desktop, it may appear to show up on the desktop. But that’s just an
optical illusion—a visual convenience. In truth, nothing in Windows XPis ever
reaily on the desktop;it’s just in this Desktopfolder, and mirrored on the desktop
area,

Rememberthat everyone who shares your machine will, upon logging on (Chapter
17), see his own stuff sitting out on the desktop. Now you know howWindows XP
does it: There’s a separate Desktop folder in every person's account folder.

You can entertain yourself for hours trying to provethis. If you drag something
out of your Desktop folder, it also disappears from the actual desktop. And vice
versa.

* Favorites. See page 658 for a definition of favorites. For now, it’s enough to note
that this folder stores shortcuts of thefiles, folders, and other items you designated
as favorites. This information can be handy if you want to delete a bunch of your
favorites all at once, rename them, and so on.

Fp: This folder may also contain a Links folder.It's the folder representation of the Links toolbar described
on page 9%,  

* My Documents. Windows XP makesit look like you're setting up your nest (your
documents, photos, music files, and so on) in the My Documents folder-—-the one
that opens when you choose Stari+My Documents. And whenever you save a
new document (when you're working in Word, for example), the Save dialog box
proposesstoring the new file in this folder. ,
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Behind the scenes, however, My Documentsis actually just one of several folders
in your own accountfolder.It’s a good idea to back this one up periodically.

» Start menu.Thisfolderis the true homefor the icons whose names appear in your
Start menu. By renaming,deleting, or adding to the contents of this folder, you
can quickly and easily reorganize your Start menu.

Your account folder actually holds much more than this, but the rest of the folders
are hidden,reserved for use by Windowsitself. The hiddenfolders include: Applica-
tion Data (which your programs may use to store user-specific settings andfiles),
Local Settings (Internet Explorer’s history list and cachefile, for example}, NetHood
(shortcuts for the icons in your My Network Places window), My Recent Documents
(document shortcuts, the ones that show up in the optional My Recent Documents
submenuof the Start menu), and SendTo, which is described later in this chapter.

Navigating My Computer
Mostofthe time, you can get where you're going on your computer using the com-
mands, programs, and folders listed in the Start menu. But when you need to find
something thatisn’t listed there-—-when you need to burrow manually through the
labyrinth offolders on the machine—-Windowsoffers two key methods of undertak-
ing a folder quest.

First, you can open the My Computer window,as described at the beginningof this
chapter. From there, you double-click one folderafter another, burrowing ever deeper
into the folders-within-folders.
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Tap: As you navigate your folders, keep in mind the power of the Backspace key. Each time you press it, you
jumpto the parent window of the one you're now looking atthe one that contains the previousfolder. For
example, if you're perusing the My Pictures folder inside My Documents, pressing Backspace opens the My
Documents window. (Backspace aiso works in most Web browsers, functioning as the Back button.)

 
Likewise, the Alt key, pressed with the right and left arrow keys, serves as a Back and Forward button, Use
this powerful shortcut (instead ofclicking the corresponding buttons on the Standard too‘bar) to “walk’
backward or forward through the list of windows mosi recently opened. 

Navigating with Windows Explorer
The second method of navigating the folders on your PC is called Windows Ex-
plorer—for long-time Windowsveterans,a familiar sight. (Note that some people
use the term “Windows Explorer”to refer to everyday folder windows. In this book,
the term refers exclusively to the split-window view shown in Figure 3-3.)

Using this method, you work in a single window that shows every folder on the
machine at once. Asa result, you're less likely to lose your bearings using Windows
Explorer than burrowing throughfolder after folder, as described above.

You can jump into Explorer view using any of these methods:

» Shift-double-click any disk or folder icon.

* Right-click a disk or folder icon (even if it’s in the Start menu) and choose Explore
from the shortcut menu.

+ Click Folders on the Standard toolbar.

* Choose View—>Explorer Bar->Folders.

* Choose Start—All Programs—>Accessories->Windows Explorer.

* Choose Start—>Run, type explorer, and then press Enter.

No matter which method you use,the resuit is a window like the one shown in Figure
3-3,

As you can see, this hierarchical display splits the window into two panes. Theleft
pane displays only disks and folders. The right pane displays the contents (folders
and files) of any disk or folder you click. You can manipulate the icons on either side
muchas you would anyothericons. For example, double-click one to openit, dragit
to the Recycle Bin to deleteit, or drag it into anotherfolderin the folderlist to move
it elsewhere on your machine.

This arrangement makesit very easy to movefiles and folders around on your hard
drive. First, make the right pane display the icon you wantto move. Then,set up the
left pane so that you can see the destination folder or disk—and drag the right-side
icon from one sideto the other.
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When the panel is too narrow
As shown in Figure 3-3, expanding a folder provides a new indentedlist of folders
insideit. [you expand folders within foldersto a sufficientlevel, the indentation may
push the folder names so far to the right that you can’t read them. You can remedy
this problem with any of the following actions:

 
« Adjust the relative sizes of the window halvesby dragging the vertical bar between

them.

° Position your mouse pointer over a folder whose name is being chopped off. A
tooltip balloon appears to display the full nameof the folder.

* Use the horizontal scroll bar at the bottom ofthe left pane to shift the contents.

 

  

 
 

Figure 3-3:
Front: Windows Explorer
offers a treetop view ofyour
computer's hierarchy. When
you click a disk or folder in
the left pane, the rightpane
displays its contents, includ-
ing files and folders. Click the
+ button to expand a disk
or folder, opening a new,
indented list of what's inside
it, Click the — button to “col-

lapse”the folder list again.
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Viewing folder contents
To see what's in one of the disks or folderslisted at theleft side of the Explorer win-
dow, you can use any of these techniques. (See the box on page 111 for details on
simple folder view.) ,

* With simplefolder view turned on:In theleft pane,click the icon, name, or + button
of a disk or folder. The branch of your folder tree expandsin theleft pane, while
the right panedisplays its contents.

CHAPTER 3: ORGANIZING YOUR STUFF oe ios 443

HP Inc.- Exhibit 1007 - Page 127



HP Inc. - Exhibit 1007 - Page 128

214

 
* With simplefolder view turned off: In theleft pane,click a folderor disk; the contents

appearin the right pane. To expandthelisting for a disk or folder, double-click its
name, double-click its icon, or single-click the + button besideit,

° Right-click a folder in the left pane and select Open from the shortcut menu. A
new window opens,displaying the contents of the folder you clicked. (To open
a program or document appearingin either side of the window, double-clickit as
usual.)

Theright-side paneof the Explorer window behavesexactly like any folder window.
Don't forget that you can changeit to an icon view orlist view, for example, using
the View menuas usual.

Keyboard shortcuts

If you arrive home oneday to discover that your mouse has been stolen, or if you
just like using the keyboard, you'll enjoy the shortcuts that work in the Windows
Explorer window:

left arrow Collapsesthehighlighted folder, orif it’s alreadycollapsed,highlights
its “parent”folder. (The + key on your numeric keypad does the same
thing.)

right arrow Expands a highlighted folder, or if it’s already expanded, highlights
the first folderinside it. (The - key on your numeric keypad doesthe
same thing.)

* (on number pad} Displays aif of the selected folder’s subfolders.
F6 or Tab Highlights the other half of the window.

Alteleft arrow Highlights whicheverfolder you last highlighted.

Backspace Highlights the “parent” disk orfolder of whateveris highlighted.
Cirl+Z Undoes whatever you just did in this Explorer window.
Home, End Highlights first or last icon in the folderlist.

ABC... Highlights the first visible file or folderin the left-pane hierarchythat
matchesthe letter you typed, Type the sameletter again to highlight
the next matchingicon.

You can also press the letter keys to highlight a folder orfile that begins with that
letter, or the up and down arrow keys to “walk” up and down thelist,

Lite with icons

Both of the navigational schemes describedso far in this chapter have only one goal
in life: to help you manage your icons. You could spend your entire workday just
mastering the techniques ofnaming, copying, moving, and deleting these icons—and
plenty of peopledo.

Here’s the crash course.
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Renaming Your icons
To renamea file,folder, printer, or disk icon, you need to open upits renaming rect-
angle. You can do so with any of the following methods:

 
: Highlight the icon and then press the F2 key at the top of your keyboard.

* Click carefully, just once, on a previously highlighted icon’s name.

* Right-click the icon and choose Rename from the shortcut menu.
 

Hip: You can even rename your hard drive, so that you don’t go yourentire career with a drive named
“1ocal Disk.” Just renameits icon (in the My Comouter window) as you would any other. You're not a+
lowed te rename important system folders like Documents and Settings, Recycle Bin, Windows, WINNT,
and Systemn32, however. 

In any case, once the renaming rectangle has appeared around the current name,
simply type the new name you want, and then press Enter. Feel free to use all the
standard text-editing tricks while you're typing: Press Backspaceto fix a typo, press
the left and right arrow keys to position the insertion point, and so on. When you're
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finished editing the name, press Enter to makeit stick. (If anothericon in the folder
has the same name, Windows beeps and makes you choose another name.)

 
A folder or file name can be up to 255 characters long, including spaces and the file-
name extension (the three-letter suffix that identifies thefile type). Because they're
reserved for behind-the-scenes use, Windowsdoesn’t let you use anyofthese symbols
in a folder or filename: \/:*?“<> |
  Tip: If you highlight a bunch of icons at once and then open the renamingrectangle for any one of them,

you wind up renaming aif of them. For example,if you've highlighted folders called Cats, Dogs, and Fish,
renaming one of them Animals changestheoriginal namesto Animals (1), Animals (2), and Animals (3).

 
If this new Windows XP feature hits you unexpectedly, press Ctrl+Z repeatedly until you've restored all the
original names; (On the other hand, if you wish you had even more mass-renaming power(the ability to
add a certain prefix to every file, for example, or even to search-and-replace text within the fies’ names), use
Better File Narne, a piece of sharewarelisted on the “Missing CD” pageat wwmnissingmanuals.com.

 
 

 
If you like, you can give more than onefile orfolder the sare name,as long as they're
not in the same folder. For example, you can have as many files named “Letter to
Smith”as you wish,as long as each is ina different folder. 
 

  
Nete:Windows XP comesfactory set not to show you filenameextensions. That's why you sometimes mignt
think you see twodifferentfiles called, say, Quarterly Sales, both in the samefolder.  
The explanationis that one filename may end with doc (a Word document), and the other may end with
ws (an Excel document}. But because thesesuffixes are hidden (page 169), thefiles look tike. they have
exactly the same name. 

 

icon Properties
As every Windowsveteran knows, properties are a big deal in Windows. Properties
are preference settings that you can change independently for every icon on your
machine.  
To view the Properties dialog box for an icon, choose from these techniques:

 
* Right-click the icon; choose Properties from the shortcut menu.

° While pressing Alt, double-click the icon.

> Highlight the icon; press Alt+Enter.

These settings aren't the samefor every kind of icon, however. Here's what you can
expect when opening the Properties dialog boxes of various icons (see Figure 3-4).

 
My Computer
This Properties dialog box is packed with useful information about your machine.

* The General tab tells you what kind of processoris inside, how much memory
(RAM) your PC has, and what version ofWindows you've got.
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¢ The Hardware tab (shown in Figure 3-4) includes a link to the Device Manager,

which breaks down your equipment even more specifically—it provides the manu-
facturer and model nameofeach component on your machine (modem, monitor,
mouse, and so on),

Figure 3-4:
The Properties dialog
boxes are different for

every kind oficon, in
the months andyears
to come, you may find
many occasions wien
adjusting the behavior
ofsome icon has big
benefits in simplicity and
productivity. Left: Two
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  apamrtte jatupadeas bowieeiiberenthase. sorviguration’

a _ Handvece Profles “al

  

The Computer Nametab is where you set up your computer’s name,as it will
appear to other people on an office network.

The Advanced tab offers buttons that serve as rabbitholes into ever more technical

dialog boxes. They include Performance(see the box on page 118), User Profiles
(see page 541), and Startup and Recovery (advanced controls related to dual-boot-
ing [page 638] and what happens whenthe system crashes).
 

Hip: One button on the Advancedtabis actually not advanced at all—the Error Reporting bultor. You may
have noticed that whenever a program crashes, freezes, or abruptly quits, Windows XPoffers to email a report
of the event to Microsoft for the benefit of its debugging teams. Using the Error Reporting dialog box, you can
turnoff this frequent attemptto contact the mother ship—orlimit theattempts to certain programs, 

* See page 475 for details on the System Restore tab, page 331 for information on
Automatic Updates, and page 139 for details on the Remotetab.

Disks

In a disk’s Properties dialog box, you can seeall kinds of information aboutthe disk
itself:
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* General. This tab shows you the disk’s name (which you can change), its capacity
(which you can’t change), and how muchofit is full. 

> Tools. Offers quick access to disk tools like ScanDisk and Defrag (Chapter 16).

> Hardware.Lists the individual drives—hard drives, CD drives, and so on—con-
nected to your machine, complete with troubleshooting and Properties buttons.

* Sharing. Controls who can access the disk, in person or by network (Chapter
20).

° Security. Not only can you share certain foldersorfiles with other people (either
across a network or when they log into your PC using their own accounts), but
you can also specify exactly whois allowed how mutchaccess to eachfile or folder.
Moreaboutfile security in Chapter 18.
 

Note: If you don't see the Security tab, it's probably because simple file sharing is tured on (see page
591). if you turin itoff, the Security tab reappears (if you've formatted your hard drive using the NTFSfile
system, as described on page 636).  

Sekect the settings you wert to use for the apheatance and
1 performance, of Windows on this carpater.i

(Set Windows choose what's best for my computer
Ch Adjust For bast appearance

5} CO) Adiust For best performance
Bi Custom:

imate windows whet trinimizh
Fade cr side morris inte view

| Be] Show shedoms under mouse pointer
LET] Show translucent selection rectangle

A. | bt] Shovewindow contents vinie dragging
| Bel Side open combo boxes
CECT Side Lasherbuttons
‘FE Smooth eceesof sereen fonts 
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> Quota.If different people use this PC, each with a different account, you can limit
the amount of disk space each person is allowed to use. Details await on page
472.

Data files

The Properties for a plain old document depend on whatkind of documentitis. You
always see a General tab, but other tabs may also appear (especially for Microsoft
Office files).

* General. This screen offers all the obvious information about the document—lo-

cation, size, modification date, the program that opens the document (which
you can change with a click of the Change button}, and so on—along with a few
interesting-looking checkboxes. For example, the read-only checkbox locks the
document.In the read-only state, you can open the documentand readit, but you
can’t make any changestoit.

Mode: \f you make 2 folder read-only, it affects only thefiles already inside. If you add additional files later,
they remain editable.

Hidden turnsthe icon invisible.(It’s a great way to prevent something from being
deleted. Of course, because the icon becomesinvisible, you may findit a bit dif-
ficult to open it yourself, unless you've turned off “Do not show hidden files and
folders” in the Folder Options dialog box, as described on page 84.)

‘The Advanced button offers a few additional options. File is ready for archiving
means, “Back meup.” This messageis intended for the Backup program described
in Chapter 16, and indicates that this document has been changedsince thelast
time it was backed up (orthatit’s never been backed up). Forfast searching, allow
IndexingService to index thisfile lets you indicate thatthis file should, or should
not, be part of the quick-search database created by Indexing Service (described
on page 50). Compress contentsto save disk space and Encrypt contents to secure
data are both described later in Chapter 15.

* Security. The Security tab shows who’s allowed to open this file or folder and how _
much freedom they have to messwith its contents (Chapter 18). You can use this
tab to delete or add groups,users, or permission.

Custom,As explained below, the Properties window of Office documentsincludes
a Summarytab that lets you look up a document’s word count, author, revision
number, and many otherstatistics. But you should by no meansfeel limited to
these 21 properties—norto Office documents.

Using the Custom tab, you can create properties ofyour own—WorkingTitle, Panic
Level, Privacy Quotient, or whatever youlike.Just type the property nameinto the
Nametextbox (or choose oneofthe cannedoptionsin the Type drop-down menu)
and then click Add. You can then fill in the Value text box for the individual file

in question {so thatits Panic Levelis Red Alert, for example}. Especially technical

 
 

CHAPTER 3! ORGANIZING YOUR STUBF 413

HP Inc. - Exhibit 1007 - Page 133



HP Inc. - Exhibit 1007 - Page 134

 

 
120

| EF] Bieable visual themes 

 

people can later use Indexing Service (see page 50) to perform query-language
searches for these values.

' The Summarytab tells you how many words,lines, and paragraphsare in a pat-
ticular Word document. For a graphics document, the Summarytab indicates the
graphic’s dimensions,resolution,andcolorsettings.

Folders

‘The Properties boxes for folders reveal the same checkbox options as foundfor data
files. But now there’s a separate tab called Sharing, which makesthe folder susceptible
to invasion by other people—either in person, when they log into this machine, or
from across your office network (see Chapters 18 and 21).

 

Program files
There’s not much here that you can change yourself, but you certainly get a lot to look
at. For starters, there are the General, Security, and Summarytabs described earlier.
But wait-—that’s notall:

* Version. This tab offers a considerable wealth ofdetail about the program'sversion
number, corporate parent, language, and so on.

 
 

Figure 3-5:
Byturning on “Run this program in compatibility modefor”
and choosing the name ofa previous version of Windows
from the drop-downlist, you can foolthatprogram into

IF you have problems vath this program and it worked correctly on thinking thatit’s running on Windows 95, Windows Me,
2atlvetsanof Windows, select the compallliy rode tna Windows NT, or whatever. While you're atit, you can also

specify that this program switch your screento certain set-
« Compatiifty made mere eas on tings required by older games~-256 colors,

: 640 x 480 pixel resolution, and so on—or without
nnn the new Windows XP look (turn on “Disable visuaf
Windows 95 oo ihemes”}.

 Run this program in compatibility mode for

(_] Bunin $40 + 480 screen resclution

input settings .
1] fum off advancad text services for this prograinS704:
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* Compatibility. There may comea day when you're moregrateful for this tab than
just about any other new Windows XP feature. The idea is to provide you with a
way out of an uncomfortable situation. An example might be when you try to run
a pre-2002 program on Windows XP, and (becauseit’s never heard of Windows
XP) it doesn’t work right, or doesn’t workat all. Figure 3-5 illustrates the magic
in action.

 

Shortcuts

You can read about these useful controls later in this chapter, 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 

 

 

Changing Your icons’ Icons
You can change the inch-tall illustrations that representthelittle iconsreplete in your
electronic world. You can’t, however, picka single method to do so, because Microsoft
has divided up the controls amongthree different locations.

For example, one approachis to changethe icon usedbyall files of a certain type. If
you're French,for example, you might want to changethe big W ona Word document
to a big M (for Mot}. Instructions appear on page 172.

You can also change the icon for someof the important Windows desktop icons: the
Recycle Bin, My Documents, and so on. Open the Display program in the Control
Panel(see Chapter8),click the Desktop tab, then click Customize Desktop. You'll see a
sliding collection ofthose important Windowsicons. Click one, and then click Change
Icon to choose a replacement from a collection Microsoft provides. (You haven't lived
until you've made your Recycle Bin looklike a green, growingtree,)

Finally, if you're sneaky, you can replace the icons for individual folder and shortcut
icons on your PC. Here’s how:

I, Right-click the folder or shortcut whose icon you wantto change. From the
~ shortcut menu, choose Properties.

_ The Properties dialog box appears.

- "2, Click the Customize tab (for a folder) or the Shortcut tab (for a shortcut). At the
bottom ofthe dialog box, click the Change Icon button,

woe _Yet another dialog box,filled with prefab replacementicons, appears. If you see
“one that suits your fancy,click it; otherwise, continue.

o 3. Click Browse,

>WindowsXP nowlets you huntfor icons on your hard drive. These can be icons
thatyou've downloaded from the Internet, icons embedded inside program files
and dil files, or icons that you've made yourself using a freeware or shareware
icon-making program like AX-Icons (available at www. missingmanuals.com,
- amongotherplaces).

Click OK twice,

    

“Youshould see your new replacementicon happily in place,
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Copying and Moving Folders and Files
Windows XP offers two different techniques for movingfiles and folders from one
place to another: dragging them, and using the Copy and Paste commands.
Whichever methodyou choose, you muststart by showingWindowswhich icons you
want to copy or move—by highlighting them.

Highlighting Icons
To highlight(thatis, select) one icon,just click it once. But you don’t have to move,
copy,or delete oneicon at a time; you can select a numberoficonsin the same folder
or disk window. You may want to employ this technique, for example, when moving
a bunch of documents from one folder to another, or copying them onto a backup
disk en masse.
 

Tip; \t's easiest to work with multiple iconsin Details view (page 81), where every icon appears in a single
colurnn.  

‘To highlight multiple files in preparation for moving, copying, or deleting, use one
of these techniques:

To highlight alf the icons
To select all the icons in a window,press Ctrl+A (the keyboard equivalent of the
EditSelect All command).

To highlight several icons
You can drag acrossfile and folder namesto highlight a group of consecutive icons.
Start with your cursor above and to oneside of the icons, then drag diagonally. As
you drag, you create a temporary dotted-line rectangle. Any icon thatfalls within this
rectangle darkensto indicate thatit’s been selected.

Alternatively, click thefirst icon you wantto highlight, and Shift-click thelastfile. All
thefiles in between are automatically selected, along with the two icons youclicked.
(These techniques work in any folder view: Details, Thumbnails, or whatever.) 

Tip: \f you include a particular icon in your diagonally dregged group by mistake, Ctr-click it to removeit
from the selected cluster.  

To highlight only specific icons
Suppose you wantto highlight onlythe first, third, and seventh iconsin thelist. Start
by clicking icon No.1, then Ctrl-click each of the others.(Ifyou Ctrl-click a selected
icon again, you deselectit. A good time to use this trick is when you highlight an
icon byaccident.)  

Yip: The Ctrl key trick is especially handy if you want to select almostall the icons in a window, Press Cirl+A
to select everythingin the folder, then Ctrl-click any unwanted subfolders to deselect them. 
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Copying by Dragging icons
As you know, youcan drag icons from onefolder to another, from one drive to another,
from a drive to a folder on another drive, and so on. (When you'veselected several
icons, drag any one of them and theothers will go alongfor the ride.)

 
Here’s what happens when you dragicons in the usual way (using the left mouse
button):

° Dragging to another folder on the same disk moves the folderorfile.

¢ Dragging from one disk to another copies the folder orfile.

!

|
» Pressing the Ctrl key while dragging to anotherfolder on the samedisk copies the = [

icon, (If you do so within a single window, Windowscreates a duplicate of the file =
called “Copyof [filename].”) ,

I* Pressing Shift while dragging from one disk to another moves the folder or file
(without leaving a copy behind).

* Pressing Alt while dragging an icon creates a shortcutofit.
 

Fip: You can move or copy icons by dragging them: either into an open window or directly onto a disk or
foldericon. 

The right-mouse-button trick
Think you'll rememberall ofthose possibilities every time you drag an icon? Probably
not. Fortunately, you never have to. One of the most importanttricks you can learn
is to use the right mouse button as you drag. When yourelease the button, the menu
shown in Figure 3-6 appears, so that you can either copy or move the icons.
 

Fp: Press Esc to cancel a dragging operation at any time.

Figare 3-6:
Thanks to this shortcut menu, right-dragging icons
is much easier andsafer than left-dragging when
you want fo move or copy something.

sorbent to=Werking:
Fish (13 ‘Outing: 
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Dragging icons in Windows Explorer
You mayfindit easier to copy or moveicons in WindowsExplorer, since the two-pane
display format makesit easier to see where yourfiles are and where they're going.(See
page 112 fora list of the ways to open the Explorer window.) Here’s how to doit:

 
1. Make the destination folder visible by clicking the + buttons next te your folder

names, expanding your folder “tree” as necessary.

For example, to copy an icon imto a certain folder, click the Local Disk (C:) icon
to see its st of folders. If the destination is a folder within that folder, expand its
parent folder as necessary.

 2. In theleft pane, click the icon ofthe disk or folder that contains the icon you want
to manipulate.

Its contents appear in the right pane.

3, Locate the icon you want to movein the right pane, and drag it te the appropriate
folder in the left pane (see Figure 3-7),

Windowscopiesthe icon.

Copying by Using Copy and Paste
Dragging icons to copy or move them feels good becauseit’s so direct. You actually
see your arrow cursor pushingthe icons into the new location.
 

 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 

 

 
Figure 3-7:
The file Working
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Notes to Self folder on

ace the desktop,is being
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But you also paya price for this satisfying illusion. That is, you may have to spend a
momentfiddling with your windows,or clicking in the Explorer hierarchy, so that you
have a clear “line of drag” between the icon te be moved and the destination folder.

Fortunately, there’s a better way: You can use the Cut, Copy, and Paste commandsto
move icons from one windowinto another. Theroutine goeslike this:

1, Highlight the icon or icons you want to moveorcopy.

You can use any of the tricks described on page 122. 

 
 Open
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Open with
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2. Right-click one of the icons. Choose Cut or Copy from the shortcut menu.

Alternatively, you can choose Edit>Cut or Edit>Copy, using the menu barat the
top of the window,(Eventually, you may wantto learn the keyboard shortcuts for
these commands: Ctrl+C for Copy, Ctrl+X for Cut.)

The Cut command makesthe highlighted icons show up dimmed; you've now
stashed them ontheinvisible WindowsClipboard. (They don’t actually disappear
from their original nesting place until you paste them somewhereelse.)

The Copy command also places copies of the files on the Clipboard, but doesn't
disturb the originals.

3, Right-click the window,folder icon, or disk icon where you wantto put the icons.
Choose Paste from the shortcut menu.

Once again, you may prefer to use the appropriate menu bar option---Edit—Paste.
Keyboard equivalent: Ctrl+V.

Either way, you've successfully transferred the icons. If you pasted into an open
window, you'll see the icons appear there. If you pasted onto a closed folder or
disk icon, you need to open the icon’s windowtosee the results. And if you pasted
right back into the same window, you get a duplicate of the file called “Copy of
[filename|}.”

The Recycle Bin
The Recycle Bin is your desktop trash basket. This is wherefiles and folders go when
they’ve outlived their usefulness,like a waiting room for data oblivion. Your files stay
here until you empty the Recycle Bin—or until you rescue them by dragging them
out again.

While you can certainly drag files or folders onto the Recycle Bin icon,it’s usually
faster to highlight them and then perform oneof the following options:

« Press the Delete key.

* Choose File>Delete.

* Right-click a highlighted icon and choose Delete from the shortcut menu.

WindowsXP asks ifyou're sure you wantto send the item to the Recycle Bin. (You don’t
lose much byclickingYes,sinceit’s easy enough to change your mind,as noted on the
facing page.) Now the Recycle Bin icon lookslike it’s brimming over with paper.
 

Tip: To turnoff the “Are you sure?" message that apoears when you send something Bin-ward,right-click
the Recycle Bin, Then choose Propertiesfrom the shortcut menu, and tumoff “Display delete confirmation
dialog.” Turning off the warning isn’t muchofa safety risk. After ali, files aren't really being removed from
your drive when you put them in the Recycie Bin. 
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You can put unwantedfiles and folders into the Recycle Bin from anyfolder window,
from within Windows Explorer, or even inside the Open File dialog box of many
Windowsapplications {see Chapter 5). 

Mage:All of these methods put icons from your Aard drive into the Recycle Bin. But deleting an icon from
a removable drive Cloppy or Zip drives, for example), or other computers on the network, does notinvolve
the Recyce Bin, giving you no opportunity te retrieve them. (Deleting anything with the DOS def or erase
commands bypasses the Recycle Bin, tao.) 

Restoring Deleted Files and Folders
If you change your mind about sending somethingto the software graveyard, open
the Recycle Bin by double-clickingit. A windowlike the onein Figure 3-8 opens.

 
 Figure 3-8;

When you double-click the
Recycle Bin (top), its window
(bottom) displays information
about each folder andfile that
it holds. To sort its contents in

Deiails view, making it easier
to find a deletedicon, click the
gray column heading for the
type of sort you need.
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 To restore a selected file or a folder—or a bunch of them—click the “Restore the

“. selected items”link in the task pane, or choose File—Restore, or right-click any one
ov) Of the selected icons and then choose Restore from the shortcut menu.

Restored meansreturnedto the folder from whenceit came—whereverit was on your
_ hard drive whendeleted. Ifyou restore an icon whoseoriginal folder has been deleted in

vo the meantime, Windows XP evenre-creates that folder to hold the restored file(s).
 

. ip: You don’t have to put icons back into their original folders. By dragging them out of the Recycle Bin
Window, you can put them inte any folder you fike. 
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Emptying the Recycle Bin
While there’s an advantage to the Recycle Bin (you get to undo your mistakes), there’s
also a downside: Thefiles in the Recycle Bin occupy as much disk spaceas they did
when they werestored in folders. Deleting files doesn’t gain you additional disk space
until you empty the Recycle Bin.

  
That’s why most people, soonerorlater, follow up an icon’s journey to the Recycle
Bin with one of these deanup operations:

+ Right-click the Recycle Bin icon,or a blank spot in the Recycle Bin window, and
choose Empty Recycle Bin from the shortcut menu.  

> Click the “Empty the Recycle Bin”link on the task pane in the Recycle Bin win-
dow.

- In the Recycle Bin window,highlight only the icons you wantto eliminate, and
then press the Delete key. (Use this method when you want to nuke only some of
the Recycle Bin’s contents.) 

* Wait. When the Recycle Bin accumulates so much stuff that it occupies a signifi-
cant percentage of your hard drive space, Windows emptiesit automatically, as
described in the next section.

Thefirst three of these procedures produce an “Are you sure?” message.

Customizing the Recycle Bin
You can make two useful changes to the behavior of the Recycle Bin. To investigate
these alterations, right-click the Recycle Bin icon and choose Properties from the
shortcut menu. The Recycle Bin Properties dialog box appears (see Figure 3-9).
  

Figure 3-9:
Use the Recycle Bin Properties dialog box to govern the
way the Recycle Bin works, or evenif it worksat all. if
you have muttiple hard drives, the dialog box offers a tab
for each of them so you can configure a separate and
independent Recycle Bin on each drive. To configure the
Recycle Bin separately for each drive, select the “Contig-
ure drives independently” option.

 
  
  
 

Global|LocalDik(C3) 
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2Lise one setting For all crivest encnnermers

  
 

 

  

[_]Do not move files to the Recycle Bin,Remove Files immediately when deleted
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Skip the Recycle Bin
Ifyou, a person ofsteely nerve and perfect judgment, never deleteafile in error, then

" yourfiles can bypass the Recycle Bin entirely when you delete them. Furthermore,
' you'll reclaim disk space instantly when youpress the Delete key to vaporize a high-

lightedfile or folder.

: ae To set this up, turn on the “Do not movefiles to the Recycle Bin” checkbox (shown
~ in Figure 3-9). Andvoila: Yoursafety netis gone. (Especiallyif you also turn off the

“> checkbox shown at bottom in Figure 3-9—then you're really living dangerously.)

~Tf that suggestion seems too extreme,consider this safety/convenience compromise:
Leave the Recycle Bin safety net in place mostofthe time, but bypass the Recycle Bin
“on commandonly when it seems appropriate.

“Thetrick to skipping the Recycle Bin on a one-shotbasisis to press the Shift key while
“you delete a file. Doing so—andthen clicking Yes in the confirmation box—deletes
~thefile permanently, skippingits layover in the Recycle Bin. (The Shift-key trick works
for every methodofdeletinga file: pressing the Delete key, choosing Delete from the
shortcut menu, and so on.)

Auxto-emptying the Recycle Bin
‘The Recycle Bin has two advantages overthe physical trash cans behind your house:
First, it never smells. Second, whenit’sfull, it can empty itself automatically.

yconfigure this self-emptying feature, you specify a certain fullness limit as a per-
centage of the hard drive capacity. When the Recycle Bin contents reach thatlevel,
Windowsbegins deleting files (permanently) as newfiles arrive in the Recycle Bin,
Files that arrived in the Recycle Bin first are deleted first.

 

~ ‘Unless youtell it otherwise, Windows XP reserves 10 percent of your drive to hold
Recycle Bin contents. To change that percentage, just move theslider on the Proper-
ties dialog box (Figure 3-9). Keeping the percentage low meansyou'reless likely to
tun ut ofthe disk space you needto install software and create documents. On the
other hand,raising the percentage means you'll have more opportunityto restore
files you later wantto retrieve.

Note:Every disk hasits own Recycle Bin, which holdsfiles and folders you have deleted from that disk.
As.youcan see in the Recycle Bin Properties dialog box, the factory setting for automatic trash-deletionis
10 percent for aif of your drives. If you click “Configure drives independently," you can use the separate dialog-
boxtabs for each of your hard drives. Accordingly, each hard drive will then Aave its own trash-limit slider
ind“Do not movefiles to the Recycle Bin” checkbox. (Noneof this affects the “Display delete confirmation

log’"checkbox on the Globaltab, which you can‘t change ona disk-by-disk basis.) 

Shortcut leons
shortcut iis a link toafile, folder, disk, or program (see Figure 3-10). You might

thinkof it as a duplicate of the thing’s icon—butnot a duplicate ofthe thingitself.
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(A shortcut takes up almost no disk space.) When you double-click the shortcut icon,
the original folder,disk, program, or document opens.You can also set up a keystroke
for a shortcut icon, so that you can open any program or documentjust by pressing
a certain key combination.
 

Figure 3-10:
You can distinguish a desktop
shortcut (left) fram its original
in two ways. First, the tiny
arrow “badge”identifies it as

Sn a shortcut, Second, its name
Target type: JPEG Image contains the word shortcut (un-

less you've renamedft or an
application has createdits own
shortcut on the desktop).

The Properties dialog box for
a shortcut (right) indicates
which actualfile or foider this

one “points” to. The Runt drop-
down menu lets you control
how the window opens when
you double-click the shortcut
icon.

 
Shortcuts provide quick access to the items you use most often. And because you can
make as many shortcuts of a file as you want, and put them anywhere on yourPC,
you can effectivelykeep an important program or document in more than onefolder.
Just create a shortcut of each to leave on the desktopin plain sight, or drag their icons
onto the Start button or the Quick Launchtoolbar. In fact, everything listed in the
Start-»Programs menuis a shortcut—even the My Documentsfolder on the desktop
is a shortcut (to the actual My Documents folder).
 

Fip: Don't confuse the term shortcut, which refers to one of these duplicate-icon pointers, with shortcut
menu, the context-sensitive menu that appears when you right-click almost anything in Windows. The
shortcut menu has nothing to do with the shortcut icons feature. Maybe that’s whyit's sometimes called
the context menu.  

Creating and Deleting Shortcuts .
To create a shortcut, right-drag an icon from its current location (Windows Explorer,
a folder window,or even the Search window described on page 37) to the desktop.
Whenyourelease the mouse button, choose Create Shortcut(s) Here from the menu
that appears.
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Tip:you're notin the mood for usinga shortcut menu,just left-drag an icon while pressingAlt. A shortcut ap-
pears instantly. (And if your keyboard lacks an Alt key~yeah,right-drag while pressing Ctri+Shift instead.) 

You can delete a shortcut the same as any icon, as described in the Recycle Bin dis-
cussion earlier in this chapter. (Of course, deleting a shortcut doesn’t delete the file
it points to.)

Unveiling a Shortcut’s True Identity
To locate the original icon (program, folder, document, or whatever) from which
a shortcut was made,right-click the shortcut icon and choose Properties from the
shortcut menu. As shown in Figure 3-10, the resulting box shows you whereto find
the “real” icon—and offers you a quick way to jumptoit, in the form of the Find
‘Target button. When youclick Find Target, you jumpto the folder that stores the
icon, which showsup highlighted.
 

Tip: Seethe little curved-arrow badgeon the shortcut's icon? Inafit of irterior-decorating passion, you can
actually change what it!ooks like. TweakUI doesthetrick; see page 662.

Shortcut Keyboard Triggers
Even after readingall of this gushing prose aboutthe virtues of shortcuts,efficiency
experts maystill remain skeptical. Sure, shortcutslet you put favored icons everywhere
you wantto be, such as your Start menu, Quick Launch toolbar, the desktop, and so
on. But they still require clicking to open, which means taking your handsoff the
keyboard—andthat,in the grand schemeofthings, means slowing down.

Lurking within the Shortcut Properties dialog box is another feature with intriguing
ramifications: the Shortcut Key text box. By clicking here and then pressing a key
combination, you can assign a personalized keystroke for the shortcut. Thereafter, o
by pressing that keystroke, you can summonthe correspondingfile, program,folder,
printer, networked computer, or disk windowto your screen (no matter what you're
doing on the PC).

 
Three rules apply when choosing keystrokes to open your favorite icons:

* The keystrokes work only on shortcuts stored on your desktop or in the Start menu.
if you stash the icon in any otherfolder, the keystroke stops working.

 
* Your keystroke can’t incorporate the Space bar or the Backspace,Delete, Esc, Print

Screen, or Tab keys.

: There are no one- or two-key combinationsavailable here.Your combination must
include at least two of these three keys—Ctrl, Shift, and Alt—and anotherkey.

Windows XP enforcesthis rule rigidly. For example,if you typea single letter key
into the box(like EZ), Windows automatically adds the Ctrl and Alt keys to your
combination (Ctrl+AH+E£). All of this is the operating systems attempt to prevent
you from inadvertently duplicating oneof the built-in Windowskeyboard shortcuts
and thoroughly confusing both your computer and yourself.
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Tip: If you've ever wondered whatit's ike to be a programmer, try this. in the Shortcut Properties dialog
box (Figure 3-30), use the Run drop-down menuat the bottom of the dialog box to choose Normal window,
Minimized, or Maximized. Byclicking OK, you've just told Windows whai kind of window you want to appear
when opening this particular shortcut.

OK, controlling your Windowsin this wayisn’t exactly the same as programming Microsoft Access, but you
are, in your own small way, telling Windows what to do.  
Burning CDs from the Desktop
In the old days (two years ago), every PC came with a CD-ROMdrive. Nowadays,
most new PCs come with a CD burner, a drive that can record new CDsthat contain

your own stuff.

If your PC has such a drive—either a CD-R drive (CD recordable, which means you
can record each disc only once) or a CD-RW drive (CD rewriteable, for which you can
buy CD-RW discs that you can erase and re-record as manytimesas you like), you're
in for atreat. For thefirst time, WindowsXP lets you burn your own CDsfull offiles
and folders without having to buy a program like Roxio’s Easy CD Creator.

That’s because Windows XP includes Easy CD Creator(piecesof it, anyway). You now
have a great feature for making backups, emailing people, or exchanging files with a
Macintosh (the resulting CDs are cross-platform). If your PC does,in fact, have a CD burner, start by inserting a blank CD. Windows
offers to open a special CD-burning window, which will be the temporary waiting
room forfiles that you wantto copy to the CD (Figure 3-11, top left).

Made: If you've turned off this feature, you can open the CD window yourself: Open My Computer, and
then double-click the CD icon,
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Now teil Windows which files and folders you want copied ontoit, using one of these
three methods:

> Scurry about your hard drive, locating the files and folders you want on the CD.
Drag their icons into the open CD window,or onto the CD icon in the My Com-
puter window.

+ Highlight the files and folders you want burned onto the CD. Choose File
- Copy. Click in the CD’s window,and then choose File—>Paste to copy the material

there.

. «Explore your hard drive. Whenever you finda file or folder you'd like backed up,

. tight-click it. From the shortcut menu, choose Send To>CD Drive.
 

7 : Mote: All of this pertains to copying everyday computerfiles onte a CD. if you want to burn music CDs,
don't use this method. Use Windows Media Playerinstead. (See page 232 for detais.) 

 
 

-. Figere 3-892
*. fop left: When you
“nsert a blank CD,

’ this window appears,
offering to open the

“CD “staging grounds”
© window that will hold
“shortcuts forthe tiles

= you want to copy.

Top right: The little
down-arrows mean,
“This icon hasn't been

bumed yet.”
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Welcome to the CO Writing Completing the CD WritingWizare i:Lowerleft: The first Wizard
screen of the CD Writing
Wizard is your only

arice to name the CD

: (even ifit's a CD-RW
disc)...

Lower right: The final
screen offers the chance

make a second copy
of the samme CD.

      
 

 

 
izes O helps you write, or record, your Hlasko 4 TD fouhave sucessbully wnitten your Ges ty the cD,sargcding drive.
  
   

Fone the time you ect to give 0G Ew CD, or just dlith Nestto use the name bela,
  

JO you Went t9 greate another > using the same files?

 
iies, wits thase files.nn wether O13 CD name:

  

   
 

 
 

  ewe His bolng written ka thee CO vi caplace any Fleeateady on the Ch if they have the sani name. 

 
 

OD softvwe developed unver boense Brom Bysis,Ine,
fe clene this wizarel, click, Firush,  (Gace the nigard after the files have bean wréten

 
 

 

 

"case, Windows now copies the files and folders into a temporary, invisible
g-tank folder. (If you're scoring at home,this folderis in the Local Disk C:)3

Doc iments and Settings—>[Your Name]—Local Settings—Application Data—>Mi-
rosoft—>CD Burningfolder.) In other words, you need plenty of disk space before

you begin burning a CD,at least double thesize of the CD files themselves.
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Yip: Rememberthat a standard CD can hold onty about 650 M8of files. To ensure that your files and folders
will fil, periodically highlight all the ‘cons in the My Computer—>CD window (choose EditSelect All). Then
inspect the Details box in the task pane to confirm that the Total File Size is within the legat limit.

Atlast, when everything looks readyto go,click the “Write these files to CD”link in
the task pane (top right in Figure 3-11), or choose File->Write these files to CD.

The CD Writing Wizard appears, as shown at bottom in Figure 3-11, to guide you
through the process of naming the new CD and burningthedisc.
et

Mote: When using a CD-RW disc (thatis, one that you can erase and re-record), you can't change the
disc's name onceit's been recorded forthe first time, You can still replaceits contents using the techniques
described here, though.

Hard-core Windows powerusers, of course, sneeratall this. Only with a commercial
CD-burning program,they point out, can you burn MP3 music CDs,create mixed-
mode CDs (containing both music andfiles}, create Video CDs (low-quality video
discs that play on DVD players), and so on.

Still, if you use your burner primarily for quick backups,long-term storage,or trans-
ferring bigfiles to other computers,a little bit of free software goes a long way.
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CHAPTER

s you've no doubt noticed, each version of Windows gets bigger and more
_capabie, but seems to come with fewer pages ofprinted instructions. In Win-
dows XP, Microsoft has relegated moreofits wisdom thaneverto online help

screens--or, even less conveniently, to Web pages on the Internet. 
 
 
 

 
 

 
 
 

 

.”On the other hand, Microsoft has improved the Help windowbyincorporatinglinks
tovarious diagnostic and repair tools, troubleshooting wizards, and help sources on

the Web.It may take all weekend, but eventuallyyou should find written information
aboutthis or that Windowsfeature or problem.

 

Navigating the Help System
To open the help system, choose StartHelp and Support, or press F1. The Help and
Support window appears,as shown in Figure 4-1. From here, you can homein on the
help screen you want using any of three methods:clicking your way from the Help

s home page, using the index, or using the Search command.

Help Home Page
The home page shown in Figure 4-1 containsthree basic areas. In theleft column:
Frequently soughthelp topics, such as “Music, video, games, and photos” and “Print-
ing and faxing.”In the right column: buttonsthat take you to specialized interactive
helpsystems andutility software.Finally, at the lower right, Microsoft treats you each
dayttoa different “Did you know?”headline,
Ifone: of the broad topics on the left side corresponds with your question, click
any topic to seea list of subtopics. The subtopic list will lead you to another, more 
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focussedlist, which in turn leads you to an even narrowerlist. Eventually you'll arrive
atalist that actually producesa help page.   

Tip: If you seem to have misplaced your contact lenses, simply adjust the type size used by the Help Center.
Click Options on the toolbar, and thenclick “Change Help and Support Center options”at the ieft side of the
window. In the right pane, under“Font size used for Help content,” you'll see the “Font size" butions—Smali,
Medium, or Large.   

So

Frequently sought topics Special heip features Figure 4&1;
When working in the Help
and Support Center win-
dow, you can use the Back,
Forward. Home, Favorites,
and History buttons on the
toolbar. They may took like
the corresponding buttons
ina Web browser, but
these buttons refer only to
your travels within the help
system, The Favorites but-
ton here represents your
favorite help pages—they're
not the same favorites you
see in Internet Explorer.

    
  

Search the Help Pages
By typing a phraseinto the Search text boxat the top of the main page and thenclick-
ing the green arrow(orpressing Enter), you instruct WindowsXP torifle throughits
10,000 help pages to search for the phrase you typed,  
Here ate a few pointers:

* When you enter multiple words, Windows XP assumes that youre looking for
help screensthat contain all of those words, For example, if you search for video
settings, help screens that contain both the words “video” and “setting” (although
not necessarily next to each other) will appear.

+ If you would rather search for an exact phrase (“video settings”), click the “Set
search options” link underneath the Search text box. The search options page
appears; at the bottom,you'll find a “Search for” drop-down menu. Choose “The
exact phrase” and then repeat the search.
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: Tip:This same drop-down menuoffers cheices like “Any of the words,” which meansthat if you type video
“settings, you'll find help pages that have ether of those words. Choosing “The Boolean phrase”fram this
drop-down menu means that you intend to use the phrases of, and, or nof in your search phrase for further

"specificity, For axamiple, entering video notsettings would yield all help pages concerning “video”that don't
°° discuss “sebings.”

 
 

“> Windowsdisplays only thefirst fifteen topicsit finds in each ofits help databases.
“Ifyowd rather see moreor fewer “hits,” you'll find an adjustmentcontrolon, once

“again, the “Set search options” page. (That pagealso lets you turn off the search
- highlight, the dark rectangle shown in Figure 4-2 that appears aroundyour search

"phrase on the resulting help pages.)
 

oa Aigitre #2
“Fach documenttitfe in the

> fist on the left is a fink that
“> opens up @ help page on
2. the rightside of the menu,
“(The dark highlighting
“shows matches for your

- + search phrase.) The
eS pestilts are divided into

- three different catego-

 
 26 recite Found for shorteut tae. © SpanSindows explorer,

P! Hes=Suggested Topics
“+(fast but limited), Full-text

2 (2: Séarch Matches (slower
2. Butmore complete), and

.. Microsoft Knowledge Base
“= (internet-based). Click
, the appropriate category

name.

 

 
 
 
 

 

 

 
 

® Right-click a file or folder.
The SEER manu displays the most commonsommands for that thers,

& Netes
To agen Windows Explorer, olick Start, point to AN
Programs, pointto Accessories, and then clkWind Explorer.

*

 

  ad appear wher wou righihelick a file
or falter on your deakios, in the right pane of a folder
yandave, ar when you right-click an eripty space an the
taskbar or desktop.
‘to display the entire #
down SHIFT while right  

fy ragna, press and hoiding.

 
 kglatedToples  
  

 
 

 

Alter each search,theleft-side list showsthree different categories of help topics:

soft, match your search phrase. Of course,ifyou and Microsoft don’t happento use
~ »Suggested Topics reveals help pages whose keywords, invisibly assigned by Micro- | : Sed |

the same terminology, you won't find what you're seekinglisted in this group.

. Full-text Search Matches are help pages on which your search phrase actually
-. appearsin the help pagetext.

“+ Microsoft Knowledge Baserefers to the massive collection of technical articles on
2 ‘the Microsoft Web site. If youre notonline, you can’t read them.
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Tip: Whenyou're on a ‘aptopat 39,000feet, you probably don't have anIntemet connection. In that case, you
may prefer that Windowsnot attempt to search the Microsoft Knowledge Base on the Internet. Click “Set search
options”just beneath the Search text box, and then turn off the Microsoft Knowledge Base checkbox.

 
 

 

Help index
The success of the Search commandboils down to your using the same terminology
Microsoft does. Sometimes, you may havebetter luck unearthinga certain help article
by clicking the Index button on the toolbar.

Doingso produces a massive list of almost every help topic in the Windowsrepertoire,
sorted alphabetically (Figure 4-3). Double-click a topic’s nameto see its correspond-
ing help page Help window’s right pane.  
If you type a few letters into the Search box, the Index scrolls to the closest match.
But if that doesn’t produce a matching entry, you canstill scroll through the index
manually.     

 
438 -

 
Figure 4-3:
As you type, Windows XP matches each character by
highlighting successive index fistings to correspond with
ihe characters you've typed so far. Mostof the entries in
the index are indented~these are the links to actual help

hortcut menus pages. Don’t waste yourtime trying to double-click the
category headings (the entries that aren't indented, but
that have indented entries underneath them.) They don’t
do anything when double-clicked, since you're supposed
to open one of the indented subentries.

 
Type in the Keyiniord te fir

nets

defined
dialing in to YPN
troubleshooter
troubleshookers

Enetwork administratorsdefined
Network and Diabup Connections

overview
access rights
autodial
autorating

F best practices
callback, configuring
callback, configuring for incoming connections
callback, using

| components, enabling
components, optional

configuring

 
J 4 Display.
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: Tip? Ordinarily, the Help windowfills most of your screen, so it may cover up whicheversteps you're trying
“49 follow, However, clicking the Change View button (above the help text in the right pane) hidesthelist of
©. topics and shrinks the help pageso it fils a much smaller window. Click the button again to return to the

> dwo-pane VIEW.

4ohat’s This?”: Help for Dialog Boxes
iyou're ever facing a dialog box (like the one shown in Figure 4-4) while scanning

““q eluister of oddly worded options, Windows XP’s “What's This?” feature can come
“tothe rescue, It makes pop-up captions appear for text boxes, checkboxes, option
~ buttons, and other dialog box elements.

You can summonthese pop-up identifiers (see Figure 4-4) in either of two ways:

oe ey Right-click something in the dialog box. In the world’s shortest shortcut menu
-- that now appears, click What’s This?
  

2 Figure @-42
“ES After clicking the question-mark icon at the

upper-right corner, you can click eny contrat
“he in the dialog box~in this case, the Screen

‘.. Area slider—io read aboutits function.
~ Jo make the pop-up box go away, click

ESanywhere within its border. When the pop-up
box containing the answer fo What's This? el Loval Disk

* appears on yourscreen, simply right-click in E) File system:—NTFS
cathe box and choose Copy (to copy the text of 2 eernewnntmmetntneers
thepop-up to the Clipboard) or Print Topic P| EB Usedspace: 2.108.891,138 bytes. 1.95 GB

_ | =(fo printthehelp pageforthat topic). FEBFreespace: °  2,752,700,418 bytes”, 2.58 GB

 

0 Capasiiye yo2°4,861,591 552 bytes 4.82 GB

Shows how much space on this disk is used and how much is
fee,

' Click the question mark in the upper-right cornerofthe dialog box, and then click
‘the element you want identified.

"Remote Assistance
_ You maythink you've experiencedstress in yourlifetime: deadlines, breakups, down-
sizing. But absolutely nothing approachesthe frustration of an experttryingto help
-@ PC beginner over the phone—for both parties. The expert is flying blind, using

_ Windowsterminology that the beginner doesn’t know. Meanwhile, the beginner
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doesn’t know what to look for and describe to the expert on the phone.Everylittle
operation takes 20 times longer than it wouldif the expert were simplyseated in front
of the machine. Both parties are likely to age ten years in an hour.

Fortunately,that era is at an end, One of WindowsXP’s biggest big-ticket featuresis
something called Remote Assistance.It lets somebody having trouble with the com-
puter extend an invitation to an expert,via the Internet. Through Remote Assistance,
the expert can actually see the screen ofthe flaky computer, and even take control
of it by remotely operating the mouse and keyboard. The guru can make even the
most technical tweaks—runningutility software, installing new programs,adjusting
hardware drivers, even editing the Registry (Appendix C)—bylong distance remote
control, Remote Assistancereally is the next best thing to being there.

Remote Assistance: Rest Assured
Of course, these days, most people react to the notion ofRemote Assistance with stark
terror. What’s to stop some troubled teenager from tapping into your PC in the middle
of the night, rummaging through yourfiles, and reading your innermostthoughts?

Plenty.First ofall, you, the help-seeker, must begin the process by sending a specific
electronic invitation to the expert. The invitation hasa timelimit: If the helper doesn't
respondwithin,say, 10 minutes,the electronic door to your PC slamsshutagain. Sec-
ond,the remote-control person can only see what’s on your screen. She can’t actually
manipulate your computer unless you grant another specific permission. Andfinally,
you mustbepresentatyour machine to make this work. The instant you see something
fishy going on, a quick tap on your Esc key disconnects the interloper.

Qe you baye a problemvith your sound card?
If you receive an audio errar massage, or if you have ganeral sound arablams, youmight have a problem with your sound card or soured card avizey, Ga to the Sound
oubleshacker foe mera assistance.
Tan you play DYDs after you fix a arable with your gound card?

Nay Hig sound dardis fine,But T cll receive an array wiessage.
£9 Yes; hig golves the prublen,

CY Tuanteskip this step Saw SY somethinglee, rrr

eS Back|). Start Over, 
 
WINDOWS XP PRO: THE MISSING MANUAL

HP Inc. - Exhibit 1007 - Page 154



HP Inc. - Exhibit 1007 - Page 155

 
 
 
 
 
 

 
 
 
 
 

 
 
 

 
 

 
 

fp7if, despite all of these virtual locks and chains, you absolutely can’tstand the idea that there’s a tiny key-
inte your PC from the Internet, choose Start—>Control Panel. Click “Switch to Classic View,”if necessary,

ndthen double-click the System icon. In the System dialog box, click the Remote tab, ang turn olf “Allow
emote “Assistance invitations to be sent from this computer.” Click OK. Now you'veeffectively removed the

“séof the Remote Assistance feature from Windows XP.

 

 
 

Remote Assistance via Windows Messenger
Windows Messengeris a little program that lets two people communicate across

Internet—by typingin a chat window,speaking into their microphones, or even
watchingeach other via a video camera. It’s all detailed in Chapter 11.

OF now, it’s encughto note that the Remote Assistance process is much simpler and
morere streamlined if both the helper and the helpee use Windows Messenger. Here’s

structions for ihe novice
tippose you're the person who needshelp. If you suspect that your expert may need
o install softwareorfiddle with your networksettings while fooling around with your

machine,sign into your PC with an Administrator account (page 517).'Then connect
-tothe Internet, and proceedlikethis:
 

“Open Windows Messenger.
Forexample, click Start->All Programs—WindowsMessenger.

- Choose Actions—>Ask for Remote Assistance (Figure 4-5).

Now the Ask for Remote Assistance dialog box appears.

 
 

 
  

 
 

“Getting going in Remote As-
“sistanceis easiest in Windows
> Messenger(leit). Just specify

© who's goingto be the lucky one
*. té:troubleshoot your machine
“ (righO.

 
 
 

 

ae.
Start a Voice Conversation...
Start ¢ Video Conversation...

Send:aaFie| orPERO.
   
  
 

  
Sand:a Messagete aMabie Device... :Go To Chat Resins
take a Phone Call
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3. Specify who’s going to help you.

If the email address ofyour personalguruis listed on the My Contacts screen,just
click the corresponding address (Figure 4-5, right). Otherwise, click the Other tab
and type the guru’s email address into the appropriate box.

4, Click OK.

Windows Messenger sendsan invisible invitation to your good Samaritan, who
sees—thousandsofmiles away, perhaps—somethinglike the top illustrations of
Figure 4-6. If your buddy accepts the invitation to help you, then the message
shownat bottom in Figure 4-6 appears, askingifyou're absolutely, positively sure
you want someoneelse to see your screen.

Figure 4-67
Both parties have to be very, verysure
that they wantthis connection fo take
place.

Top (expert's screen): Somebody
wants your attention, master!

Middle (expert's screen): Click Accept
or press Alt+T.

Bottom (beginner's screen). You must
confirm one fast time that you really
want a visitation from someone who's

technically savvier than you. 
 
  

 

Assistance. Oo you wantto Accant (AIT) or

Decline pee) the invitation?
 

 “sistance...

Franko has accepted your Remote Assistanceinvitationandis ready to .
connect ta your computer. . conde

Do you want to let this person view yourstrean arid chat with your.’ =
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You're in good shape. Let the help session begin (Figure 4-7).

heonly further action that’s required on your part comes whenthe expert asks for
ermission to take charge ofyour machine.You'll see a request like the one shownin |

Figure 4-8. Click Yes, and then watch in amazement and awe as your cursor begins - |
flying around thescreen,text typesitself, and windows open andclose by themselves.
That’s just yourfriendly neighborhood computer wizard fixing your machine.
 

2S Figere &F: Take Control button Scale/Actual buttons
ffthe vietim’s screen isn’t
°:. exactly the same size

-- asyours, you have two
options. ifyou click Actual

“o? Sire the other person's
> screen is represented at
full size, although you
“may have to scroff around

“> fa see all ofit. Ifyou
Eo: dick Seale to Window,

“pe Windows compresses
S. (or enfarges) the other
: person's screen image

to fit inside your Remote
'o: Assistance window, even

though the result can be
: distorted and ugly.

Mawr Buces

  
Chat area Real taskbar The beginner's taskba

_ As noted earlier, if the expert’s explorationsofyour system begin to unnerve you,feel
- free to slam the doorbyclicking the Stop Control button on the screen—orjust by
Pressing the Esc key. Yourfriend can still see your screen, but can no longer control

"It. (To close the connection completely, so that yourscreen isn’t even visible anymore, . | ;
’ click the Disconnect button.) me

instructions for the expert
_Whenyourless-fortunate comrade sends you anelectronic invitation to help, a little

. Message on your Notification Area pops up, as shown in Figure 4-6 at top. Further-
more, the Windows Messenger on your taskbar changescolorto signal the invitation.
Bring Windows Messengerto the front, and then click Accept or press Alt+T (Figure

_ 4-6, middle). Assuming that the hapless noviceis skilled enoughtoclick Yesto grant
2 final permission (Figure 4-6, bottom), you'rein.
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 Atthis point, you observe a strange sight: the other person's screen in a special Re-
mote Assistance window (Figure 4-7). To communicate with yourtroubled comrade,
use any of the Windows Messenger communicationstools described in Chapter 11
(chat, microphone, video, sendingfiles back and forth)—-orjust by chatting on the
telephonesimultaneously.

When you want to take control of the distant machine, click the Take Control but-
ton on the toolbarat the top of your Remote Assistance screen. Of course, all you've
actually doneis just ask permission to take control (Figure 4-8). If it’s granted, you
can now use your mouse, keyboard, and troubleshootingskills to do whatever work
you need to do. Whenyourjob is done,click Disconnect on the toolbar—orwait for
your grateful patient to do so.
 

Tip: Once you'vetaken control of ihe other person's screen, your first instinct might be to close the gargan-
tuan Remote Assistance window that'sfilling most of the screen. Don'tIf that window clases, the connection
closes, too. What youreally wantis to minimizeit, so it’s out of your way but not closed. 

 

 
o a

Figure 4-8:
Top (beginner's screen): Now the
expert wants fo touch, notjust look,
You're not actually relinquishing
control ofyour PC—you're going to
share ff. Both you and your expert
will be able fo move the mouse and

type simultaneously~a comical,
strange, andfairly useless phenom-
enon, It’s probably best to keep
your hands offyour own machine
while the workis being conducted.

 

 
 

  

Franko vould like ts share controlof Your computer ta help solve the 7:
problem. . : Cet noes 

  
 

  
  
  
  
 

Do youwish to let Franko share controlof your computer? S LO 

 

* This recommended that you and Franko donotuse —-
he mouse at the same time. You can moniter all.

activity and ston controlat any timé by pressing the :
2 E5C key. Note that using any key sequence or- _

combination including the ESC key will alsa stap “9° 5°
* controk

 
Bottom (expert's screen): Once
you're controlling the other
machine, you can cancel at any
time, too.

You now are sharing control of Robirega23’s computer. Click in Rebinegg23's
streen to get started,

Conit-of wil return to Robineqa2F youpress the ESC kay,of ery key
sequence or combination including the ESC key (such as ESC+TAB)

 
Remote Assistance without Windows Messenger
As notedearlier, using Remote Assistance is mostefficient andsatisfying when beth
participants fire up the Windows Messenger program. That's not technically neces-
sary, however. Although more steps are involved, anybody with Windows XP can 
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=: help anyone else with WindowsXP, even if neither person has a Passport noruses
Windows Messenger.

“Instructions forthe novice
If you're the one who wantshelp,send aninvitationlike this:
L Choose Start>Help and Support.

‘The Help and Support Center appears,as described earlier in this chapter.

; 2.‘Click “Invite a friend to connect to your computer:with Remote Assistance.” On
“the next screen,click “Invite someone to help you.”

~The Remote Assistance Wizard is guiding you through the process of sending an
| invitation. You're offered two ways of sendingit: usingWindows Messenger, exactly
“as described in the previous section, and using email. Of course, since the entire

7 purposeofthis exercise is to seek the help of someone who doesn’t have Windows
2 Messenger, proceed like this:

23. Type your guru’s email address into the “Type an email address” box, and then
lick “Invite this person” (or press Enter),

This works only ifyou've already set up your PC for email, as described in Chapter
12.

 
 
 

Now the screen changesagain.

 
 
 

‘Figure 4-0;
2.Speaking ofsecurity, you can

‘also set up a password here
for ever more protection. The
guru won't be able to connect

to.your machine without the
“password. (Of course, you

-needto find some way of
telling him what the password
ismaybe calling on the

oneor sending a separate
email)

 
 
 
 
 
 
 
 

 
 
 

 
 
 

Pe dd ta Bavarian a ChangeWe
 

 Rerriets Assistance - E~nail an Invitetien

 
 

   

 
 £  Totessen the chancethat someone fraudulently gains xocess be your computer yoo can birdt the tina In which a recipient car atcapta
2 Retnote Assistance Invitation, Specify the duration thet this invitation wil remain oper,
 
 
 
 
 

 
 For secgity reasons, Ris strongly recowmnendad that you set 4 password that the recipient must use te conriect be your computer, Da

netuse your nehwork or Windses lagen password,

   
 

Confirm passwoedt

 

Upeiabeneinytateg

STATISACRNetotemsmen
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Mote: If you click “Saveinvitation asa file (Advanced),”instead, Windowssavesa little invitation ticket (with
the unusually long filename extension .tsRcincident) asa file on your hard drive. You can transfer thislitte
file—the actual invitation to inhabit your PC—-via disk or via network instead of emailing it.

 
 

4. In the From box, type the name you wantto appear on the invitation. In the
' Message box, add a description of the problem, and then click Continue.

On this screen, Windows wants to knowhow long you wantto keep yourelectronic
invitation alive (Figure 4-9), Ifyour guru doesn’t respond within,say, an hour, you
may want the invitation to expire quietly, for security reasons. 

Tip: On the other hand,if the expert is a friend or family member whorescues you frequently, you may
as well change the settings to the maximum—30 days—so that he can tap into your machine wheneverit’s
convenient. (in fact, in the Control Panel program called Systern [page 295], you can crank up the maximum
to 99 days by clicking the Remote tab and then Advanced.) You save several connection steps this way. 

5, Set up your security options. Make sure you're online, and then click the Send
Invitation button.

Alittle dialog box may appear, warning you that a program is attempting to send
an email message on your behalf. (This dialog box is designed to be a safeguard
against viruses that transmit themselves without your knowledge.)

6. Click the Send button.

Finally, the Remote Assistance wizard tells you, “Your invitation has been sent
successfully.”
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~ fastructions for the expert
“Whenthe novice sends you an email invitation,it arrives in your email program with
an attachment—a tinyfile called rcBuddy.MsRcIncident (see Figure 4-10). This is

> your actual invitation, a Remote Assistance ticket.
When you openit, a little electronic message goes back to the novice, where a mes-
->gage like the one shown at bottom in Figure 4-6 appears. The online help session can

» dow begin.

| Getting Help from Microsoft
: “Tfyou run into trouble with the installation—or with any Windows XP feature—the
“ world of Microsoft is filled with sources of technical help. For example, you can

consult:
 

Figure 4-40:
You, the guru, have just received a
_MsReincidentticket—an invitation

to help somebody whose PC needs
troubleshooting. Lucky you!

And by the way:ifthe novice, a
trusting individual. has sent you
a Remote Assistance ticket that

doesn't expire for a very long time
(99 days, for example), keep it
around on your desktop or in your
Start menu. From now on, both of
you can skip alf ofthe invitation-
and-response rigamarole. Now,
whenever he needs your help, he following the instructions at:
can just call you up or email you.
And all you have te do is double-
dick your ficket and wait for the OK
from the other side.

OU.HAVE RECETVED:

be included betow.

 
 
 

 
 

* The Microsoft Help Web pages. Direct your Web browser(if, indeed, your com-
puter works) to www.microsoft.com/support. There you'll find a longlist of help
resources that handle many of the most common questions: a database of help
articles that you can search,alist of known glitches that Microsoft has published,
newsgroups (Internet bulletin boards) where you can post questions and return
later to read the answers, and so on.

 

* Free phone help. If you bought Windows XP (thatis, it did't come on your
computer), you can call Microsoft for free phone help during business hours. The
companyis especially interested in helping you get WindowsXP installed and run-
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“his “Slson would like your assistance.4 personal message may

You can easily provide assistance from your computer by  
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ning correctly—you cancall as often as you like for help getting Windows going
this way.

After that, you can call for everyday Windows questions for free—twice. You'll
be asked to provide your 20-digit product ID number, which you can look up by
right-clicking My Computer in your Start menu andclicking the Properties tab,
The not-toll-free numberis (425} 635-3311.

(If Windows XP camepreinstalled in your machine, on the other hand, you're
supposed to call the computer company with your Windows questions.)

« Expensive phone help. Once you've used up your twofreecalls, you can still call
Microsoft with your questions—butit will cost you $35 per incident. (Theysay
“per incident”to makeit clearthat ifit takes several phonecalls to solve a particular
problem,it’s still just one problem.) This service is available 24 hours a day, and
the U.S. numberis (800) 936-5700.
a

Tip: |f you're not in the United States, direct your help calis to the local Microsoft office in your country. You'l
find a list of these subsidiaries at wwwimicrosoft. com/support 
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en you get right down toit, an operating system like Windowsis noth-
ing more than a homebase from whichto launch applications (programs).
And you, as a Windowsperson, are particularly fortunate, since more

ogtatiis are available for Windowsthan any other operating system on earth.
 i vhenyou launch a program, you're no longer necessarily in the world Microsoft

signed for you. Programs from other software companies work a bit differently,

idthere’salot to learn about how Windows XP handles programsthat were born

w. documents, programs, and Windows communicate with each other.

 | nching Programs
dowsXP lets you launch (open) programsin many different ways:

sé4program’s name from the Start>All Programs menu.

aptogram’s icon on the Quick Launch toolbar (page 99).
 
 

D uble-“click an application’s programfile icon in the My ComputerLocal Disk
Program Filesapplication folder, or highlight the application’s icon and

|n press Enter.
$sakey combination you've assigned to the program’s shortcut (page 131).
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* Choose Start+Run, type the program file’s name in the Open text box, and then
press Enter.  

> Let Windowslaunch the program for you,either at startup (page 33) or at a time
you've specified (see Task Scheduler, page 491).

 

* Open a documentusing any of the above techniques;its “parent” program opens
automatically. For example, if you used Microsoft Word to writeafile called Last
Will and Testament.doc, double-clicking the document’s icon launches Word and
automatically opensthatfile.

What happens next depends on the program you're using (and whetheror not you
opened a document). Most present you with a new, blank, untitled document. Some,
such as FileMaker and Microsoft PowerPoint, welcome you instead with a question:
Do you want to open an existing documentor create a new one? And a few oddball

_ programs,like Adobe Photoshop, don’t open any windowatall whenfirst launched.
The appearance of toolpalettes is the only evidence that you've even opened a pro-
gram.

Switching Programs
In these days where PCswith 256, 512 or even gigabytes of RAM are common,it’s the
rare PC user who doest’t regularly run several programs simultaneously.

 
The key to juggling open programsis the taskbar, whichlists all open programs (Figure
5-1). As explained at the end of Chapter2, the taskbaralso offers controls for arranging
all the windowson yourscreen, closing them via the shortcut menu,and so on.

Figure 5-3:
Top: Press Alt+Tab to highlight
successive iconsin thelist.

When you release the Alt key,
ihe program whose icon you've
highlightedjumps to the front.  
Sottom:The taskbarlets you
know which programsare run-
ning; the darkest button tells you
which program is active.
 

To bringa different program to the front, you can use any of these four tricks:

° Use the Taskbar. Clicking a button onthe taskbar makes the corresponding program
pop to the front, along with anyofits floating toolbars, palettes, and so on.  
Ifyou see a parenthetical numberon a taskbar button, however, then button group-
ing is under way (page 93). In that case, clicking the taskbar button doesn’t bring
the program’s windowsforward. You mustactually click a selection in the taskbar
button’s menu of open windows.
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me :Click the window. You can also switch to another program byclicking the part of
- its windowthat’s visible in the background.

:The relaunch technique. Repeat the technique you used to initially launch the
“program {chooseits name from the Start—All Programs menu,pressits keystroke,

y _and so on).
aAltTab. Finally, you can bring a different program to the front without using the
-pnouse.Ifyou press Tab while holding down theAlt key, a floating palette displays
“the icons of all ranning programs, as shownat the top in Figure 5-1. Each time
you press Tab again (still keeping the Alt key down), you highlight the next icon;
HS when you release the keys, the highlighted program jumpsto the front, as though

in a high-tech game of Duck Duck Goose.

“To move backward throughthe open programs,press ShifttAlt+Tab. 

7ip:For quick access to the desktop,clear the screen by clicking the Desktop button on the Quick Launch
~toalbar (its icon looks like an old desk blotier)—orjust press the Windowslogo key+D.Pressing that keystroke
a again brings ali the windows back to the screen exactly as they were. 
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Exiting Programs

When you exit, or quit, an application, the memory it was using is returned to the
Windowspotfor use by other programs. ,

If you use a particular program several times a day,like a word processoror calendar
program,you'll save time in the long run by keepingit openall day long. (You can
always minimize its window to get it out of the way when you're not usingit.)

But if you're done using a program for the day, exit it, especially if it’s a memory-
hungry onelike, say, Photoshop. De so using one of these techniques:

* Choose FileExit.

* Click the program window’s Close box, or double-click its Control-menuicon {at
the upper-left corner of the window).

« Right-click the program’s taskbar button and choose Close from the shortcut
menu.

> Press Alt+F4 to close the window you'rein.(If it’s a program that disappears entirely
when its last document window closes, youre home.)

* Press Altt+Ethen X.

If you haven't yet saved the changes you've made to your document, the program
offers the chance to do so before it shuts down all the way. Finally, after this step, the
program's windows, menus, and toolbars disappear, and you fall “downalayer” into
the window that was behindit.

When Programs Die

Windows XP itself may be a revolution in stability (at least if you're used to Win-
dows Me}, but that doesn’t mean that programs never crash or freeze. Theycrash,all
right-—it’s just that in XP, you rarely have to restart the computerasa result,

When something goes horribly wrong with a program, your primary interest is usu-
ally exiting it in order to get on with your life. But when a programslocks up (the
cursor moves, but menus and tool palettes don’t respond) or when a dialog boxtells
youthat a program has “failed to respond,” exiting may not besoeasy.After all, how
do you choose FileExit if the File menuitself doesn’t open?

As in past versions of Windows, the solution is to invokethe “three-fingeredsalute”:
Ctrl+Alt+Delete. What happens next depends on whetheror not your PCis part of
a domain network (page 19):

* Part of a domain.Ctrl+Alt+Delete summons the WindowsSecurity dialog box, a
special window shown at top in Figure 5-2. Click the Task Manager button. The
Applications tab on the resulting dialog box (Figure 5-2, bottom) providesa list
of every open program. Furthermore, the Status.column should make clear what
you already know: that one of your programsis ignoring you.
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’ Part of a workgroup (or not networked). You save a step, Ctrl+Alt+Delete brings
you directly to the Windows Task Manager dialog box (Figure 5-2, bottom).

cethNN

Tip: You can also run Task Manager by right-clicking the taskbar and then selecting Task Managerfrom the
shortcut menu. Doing this bypasses the WindowsSecurity dialog box and brings you directly to Windows

Task Manager, with the Applications tab selected. Orjust press Shift+CtrlsAlt+Delete,  

: As shown in Figure 5-2, shutting down the troublesome program isfairly easy; just
‘click its name andthen click the End ‘Task button,(If yet another dialog box appears,
{telling you that “This program is not responding,”click the End Nowbutton.)  

Figure 5-2;
*: Jap: Click the Task Manager button on the

Windows Security dialog box to check on the
status of a troublesome program.

- Bottom: Asifyou didn’t know, one ofthese
= programsis “not responding.” Highlight its
“name and then click End Task to slap it out of
= jis misery. Once the program disappears from

the fist, clase the Task Manager and get on
tft yourlife. You can even restart the same

program right eway-ne harm done.

  
Running —
Running
Net Responding
Running

i ja fish story - Microsoft Word Running
; working Gutline - Microsoft Word Auaning

Running
Running 
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 Whenyoujettison a recalcitrant program this way, Windows XP generally shuts down
the troublemaker gracefully, even offering you the chance to save unsaved changes
to your documents.
i

Yip: \f even this treatment fails to close the program, you might have to slarn the door the hard way. Click the
Processes tab, click the nameof the program that’s giving you grief, and then click the End Process button.
(The Processeslist includes dozens of programs, including manythat Windows XPruns behindthe scenes.
Finding the abbreviated short nameofthe program maybe the hardestpart of this process.)

Any unsaved changesto your documents will be ‘ost usingthis method~but atleast the frozen program is
finally dosed.  

Saving Documents
Inafew programs, such as the Calculator or Solitaire, you spend your time working
(or playing) in the lone application window. When youclose the window,notrace
of your work remains.

You chose io end the nontesnansive program, WordPad
#FC Appication.

“Phease tell Mice this prablem.
ovahave diated: an ana miner thatpou oan sar Gs tnpnove

‘WiordPad MFC Application: We vail heatthis repo as confidential arid 
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Mostprograms, however,are designedto create docurments—tiles that you can re-open
for further editing, send to other people, back up on another disk, and so on,

That’s why these programsoffer File~>Save and File--Open commands, which let
you preserve the work you've done, saving it onto the harddrive as a new file icon so
that you can returntoit later.

 
The Save File Dialog Box
When you choose File—Save for the first time, the computer shows you the dialog
box shown in Figure 5-3, in which you're supposed to type a file name, choose a
folder location, and specify the format for the file you're saving, Using the controls
in this dialog box, you can specify exactly where you wantto file your newly created
document.

Figure 5-3: Back New Folder
Top: These buttons varyby ap-
plication, but the basics always
help you navigate and view your
files and folders.

Bottom: The buttons at the left
side of the Save As dialog box
provide quick access to the folders
where you're most likely to stash
newly created documents. the My
Documents folder, the desktop
itself, andso on. But by using the
“Save in:” drop-downlist at the
iop of the screen, you can choose
any folder you fike. My PlecentDocuments

Up One Level—-Views

ae
MyNetwork,

 
Saving into My Documents
Thefirst time you use the File->Save commandto saveafile, Windows proposes your
My Documentsfolder as the new homeof the documentyou've just created (Figure
5-3). Now you're free to navigate to some other folder location, as described in the
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Be

next section, But the My Documents folder will suggestitself as the new-document
receptacle every time.
 

Tip: Many programslet you specity a different folderas the propased location for saved (and reapened)
fles, In Microsoft Word, for example, click Tools—>Options—sFile Locations tab to change the default folders
for the documents you create, where yourclip artis stared, and so on.  

What’s the benefit? First, using the My Documents folder ensures that yourfile won't
fall accidentally into some deeply nested folder where you'll never see it again (a
common occurrence amongfirst-time computer users). Instead, the newly minted
document will be waiting for you in the My Documents folder, which itself is very
difficult to lose.

Second,it’s now very easy to make a backup copy of your important documents,
since they’re all in a single folder (which you can drag onto a backup disk in one
swift move).

'There’s a third advantage, too: Whenever you use a program’s FileOpen command,
Windows once again displays the contents of the My Documents folder. In other
words, the Documents folder saves you time both when creating a new file and when
retrieving it.  

Tip: \f the Documents folder becomescluttered,feel free to make subfoldersinside it to hold your various
projects. You could even create a different default folder in My Documents for each program.

And incidentally, you're not stuck with Microsoft's favorite four folders listed at theleft side (My Documents,
Desktop, and so on). With a little help fromm TweakUl, a free program described on page 662,you can add
she icons of any favorite folders you'dlike here, 
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Navigating in the Save As Dialog Box
Ifthe My Documents method doesn’t strike your fancy, use the Save As dialog box’s
various controls to navigate your way inte any folder. That’s the purposeof the “Save
in:” drop-down list at the top of the dialog box.It lists, and lets you jumpto, any disk
or folder on your PC—or the desktoplevel, if that’s a more familiar landscape.

 

_Tosaveanew document onto,say, a Zip disk or floppy, choose the drive’s name from
this drop-down list before clicking the Save button.To saveit into afolderwithinadisk,
“simply double-click the successive nested folders until you reach the one you want.
 

- Use the toolbar icons shown in Figure 5-3 to help you navigate,like this:

S “= * Back shows you the contents of the last folder you browsed. Click its tiny black
ry down-triangle button to see a drop-down list of folders you've opened recently

within this program.

Tip: In Microsoft Office, if you paint to this button without clicking, a tooltip identifies the previous folder
- byname.
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* Up One Level moves you up onelevel in your folder hierarchy (from seeing the My
Documents contents to the hard drive’s contents, for example). Keyboard shortcut:
the Backspace key.

 
* Create New Folder creates a new folder in the current list of files and folders,

Windowsasks you to nameit.

* Views changesthe wayfile listings look in this dialog box. Each time you click the
icon, you get a different view: List, Details, Thumbnails, and so on. (To cheose
one of these views by name, use the drop-downlist rather than clicking the icon
repeatedly.)

Thelist ofview options here depends on the program you're using.In general, they
closely correspond to the View menu options described on page 78. But in some
programs, including Microsoft Office programs, you may receive a few additional
options—~a choice of Large Icons or Small Icons,for example, ot a Properties view
that divides the window in half, with the list of files and folders on theleft, and

the properties(file size, date modified, and so on) ofthe highlighted icon on the
right.

In some programs {such as Microsoft Office), you mayfind a few additional buttons
_across the top ofthe Save As dialog box,including:

* Search the Web closes the Save As dialog box, opens your browser, connects to the
Internet, and prepares to search the Internet. (Next assignment: To figure out why
you'd want to search the Web at the momentof saving your document.)

» Delete flings a highlighted file or folder into the Recycle Bin.

* Tools is drop-down menuthat offers some very useful commands,including Delete
and Rename,that let you manageyour files right from within this dialog box. Add
to Favorites creates a shortcut of the highlighted disk, server, folder, or file in your
Favorites folder, so that you don’t have to burrow through your folders every time
you want access; instead, just click the Favorites folder icon, which also appears
in the Save As dialog boxes of Office programs, to see everything you've stashed
there. The Properties commandlets you see an icon’s description and stats.

Map Network Drive lets you assign a drive letter (such as G:) to a folder that’s
on another PC of your network. Having that folder appear on your screen as just
another disk makes it much easier to find, open, and manage. (See Chapter 20 for
more on sharing networked folders.)

Navigating the List by Keyboard
When the Save As dialog boxfirst appears, the “File name”text box is automatically
selected so that you can type a name for the newly created document.

But as noted earlier in this chapter, a Windows dialog box is elaborately rigged for
keyboard control. In addition to the standard Tab/Space bar controls, a few special
keys work only within thelist of files and folders. Start by pressing Shift+Tab (to
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shift Windows’attention from the “File name”text box to the list of files and folders)
and then:

> Press various letter keys to highlight the correspondingfile and folder icons. To
highlight the Program Files folder, for example, you could type PR.(If you type
too slowly, your key presses will be interpreted as separate initiatives—highlighting
first the People folder and then the Rodents folder, for example.)

 

* Press the Page Up or Page Down keysto scroll the list up or down. Press Home or
Endto highlight the top or bottom item in thelist.

> Press the arrow keys (up or down)to highlight successive icons in thelist.

« Whena folder(orfile) is highlighted, you can open it by pressing the Enter key
(or double-clicking its icon, or clicking the Open button).

The File Format Drop-Down Menu
The Save As dialog box in many programsoffers a menu offile formats (usually re-
ferred to as the file type) below the “File name” text box. Use this drop-down menu
when preparing a documentfor use by somebody whose computer doesn’t have the
same software.

For example, ifyou've typed something in Microsoft Word, you can use this menu to
generate a Web page documentor a Rich Text Format documentthat you can open
with almost any standard word processor or page-layout program.

Closing Documents
You close a document windowjust as you'd close any window,as described in Chapter
2: by clicking the close box (marked by an X) in the upper-right corner of the win-
dow, by double-clicking the Control-menu icon just to the left of the File menu, or
by pressing Alt+F4, If you've done any work to the documentsincethelast time you
saved it, Windowsoffers a “Save changes?” dialog box as a reminder.
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As described on page 76, sometimes closing the window also exits the application,
and sometimes the application remains running, even with no document windows
open. And in a few really bizarre cases,it’s possible to exit an application (such as
Outlook Express) while a document window (an email message) remains open on
the screen,lingering and abandoned!

The Open Dialog Box
To reopen a documentyou've already saved and named, you can pursue anyof these
avenues:

* Open your My Documents folder (or whichever folder contains the saved file).
Double-click thefile’s icon.

: Ifyou've openedthe documentrecently, choose its namefrom the Start+MyRecent
Documents menu.(If you don’t see this command,simply install it as described
on page 54.)

° Ifyou're already in the program thatcreated the document, choose File>Open—or
check the bottom of the File menu. Many programsaddalist of recently opened
files to the File menu,so that you can choose its nameto re-open it.

° Type (or browse for) the document’s path and nameinto the Start—>Run box or
into a folder window’s Address toolbar.

The Open dialog boxlooks almostidentical to the Save As dialog box. The big change:
The navigational drop-downlist at the top of the window now says “Look in”instead
of “Save in.”

Once again, you start out by perusing the contents of your My Documents folder.
Here, you may find that beginningyour navigation by choosing Look In-+My Com-
puter offers a useful overview of your PC when you're searchingfor a particular file.
Here, too, you can open a folder or disk by double-clicking its namein thelist, or by
pressing the keystrokes described in the previous section. And once again, you can
press Backspace to back outof a folder that you've opened.

Whenyou'vefinally located the file you want to open, double-click it or highlightit
(from the keyboard,ifyou like), and then press Enter.

In general, most people don’t encounter the Open dialog box nearly as often as the
Save As dialog box. That’s because Windowsoffers many more convenient ways to
open a file (double-clicking its icon, choosing its name from the Start>My Docu-
ments command, and so on), but only a single way to save a newfile.

Moving Data Between Documents
You can’t paste a picture into your Web browser, and you can’t paste MIDI music
information into your word processor. But you can put graphics into your word
processor, paste movies into your database, insert text into Photoshop, and combine
a surprising variety of seemingly dissimilar kinds of data. And you can transfer text
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from Web pages, email messages, and word processing documents to other email
and word processingfiles; in fact, that’s one of the most frequently performed tasks
in all of computing.

Cut, Copy, and Paste
Most experienced PC users have learned to quickly trigger the Cut, Copy, and Paste
commands from the keyboard—without even thinking. Figure 5-4 provides a re-
cap.

Bearin mind that you can cut and copyhighlighted material in any of three ways: First,
you can use the Cut and Copy commands in the Edit menu; second, you can press
Cerl+X (for Cut) or Ctrl+C (for Copy); and third, you can right-click the highlighted
mnaterial and choose Cut or Copy from the shortcut menu.

 
Figure 5-4:
Suppose you want fo email
some text on a Web page to
a friend.

Left: Start by dragging through
it and then choosing Copyfrem
the shortcut menu (or choosing
Edit-—+Copy). Now switch ta L || eating. Imuntadothoteverwouldbore.FF guesnad tts ta he your nast camer afer that Epson

Coriditions of application for emu farm licence

Pant Kent, Cheensiand Pouinyfdsearch snd Bevelyoment Contra, OF!

your emailprogram andpaste : business, but bast of luck, Frank
it into an outgoing message veer .
(righ). 
 

When you do so, the PC memorizes the highlighted material, socking it away on an
invisible storage pad called the Clipboard. Ifyou choose Copy, nothingvisible happens;
if you choose Cut,the highlighted material disappears from the original document. 
At this point, you must take it on faith that the Cut or Copy command actually
worked, (Windows XP no longer automatically pops open the Clipboard Viewer, as
did previous Windowsversions.)

Pasting copied or cut material, once again, is something you can do either from a
menu (choose Edit—Paste), by right-clicking and choosing Paste from the shortcut
menu, or from the keyboard (press Ctrl+V).

The most recently cut or copied material remains on your Clipboard even after you
paste, makingit pessible to paste the same blob repeatedly. Such a trick can be useful
when,for example, you've designed a business card in your drawing program and
want to duplicate it enough times to fill a letter-sized printout. On the other hand,
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wheneveryounext copy or cut something, whatever waspreviously on the Clipboard
iPmbTantaty is lost forever.

Drag-and-Drop
As useful and popularasit is, the Copy/Paste routine doesn’t win any awardsfor speed;
after all, it requires four steps. In manycases, you can replace that routine with the
far more direct (and enjoyable) drag-and-drop method. Figure 5-5 illustrates how
it works.

POWER USERS’ CLINIC

ClipBook Viewer: The Missing Manual

164

The ClipBook Viewer of previous Windows versions is still
available in Windows XP Pro; it's just hidden: To open it
faorocsiogisi| eeescIENUFea2)e1Cd >CommaclotconceaagColm

As you cut or copy Information (from a word processor,
\Web page, of whatever), itshows up in the Clipboard win-
dow within the ClipBook

Viewer. Normally, cutting

of copying anything new
replaces what was onthe
Clipboard before—but
that's where the ClipBook
Viewer comes into play. It

SMO Rie](om tnemaUsacra)
Clipboard contents for

mAeee ala

Lallicuse

es are called Service Packs.

Microsoft continually works to improve its software. Ac part of this effort, wo de
velop updates and fixes to recognized issues and release them for customers,
On s regular basis, we combine many of these fixes inte a single packaye and
make the package avallahle for you ta install on your computers. These packag

long as you rememberthe name of the folder where you
Sean UlSpe)B

OhccutcommenanencteecNnealosm CeNEeCons\Tonelle
fingers Some exercise; the whole point is to retrieve them
laterto use in your documents Here again, the instructions

vary.

BleePMISOLSMELT

the Local ClipBook win-
ee MCOM NSU (uOercyclisaE
a list-of your file names

doesn’t appear in this
window, click View->
Table of Contents, Dou-

ble-click the file name 
re-uselater.

The instructions depend
on what kind of network you're on (if atall): here goes:

Braeam Ateem ©NISMSSsLorelanNom cere)PcleranLoLa
Window: +Local CipBook window, and then choose Edit
Paste. When the Paste dialog box appears, type a namefor
the page of information stored in the Clipboard. Click OK
freeem nM INOAMRIOeM COMs ILcom (OURas NomeERI TICIN (ets
work this way, pasting.and saving each newly copied scrap
OA

Workgroup networks (or no network); In ClipBook Viewer,
choose File->Save As. Name and save the scrap of infor
mation you've copied, and then click Save. You can save
as many files a5 you want and then retrieve then later (as

Neva RaSeM Eseearls
Hip ceu cenMoyenea) Pye) (omentetS

one you're leoking for, and then choose Edit-+Copy,Voila!
You've putthe information from the Local ClipBook window
back into the Clipboard window, ready for pastinginto 2 -
Hofad astcinerseeopel MalolsnncelNAUTOE eM (ESIomeUibaAmate
clicking anywhere within your documerit and thenselecting
Hochst fCoygatlaomaOy EGU] eI LcaN OpROliReNOLO(trees aOllerstrc(c)

Workgroup networks (or no network): in the ClipBook
Viewer, choose File->Open. Locate the scrap you saved
earlier, open it, and OK the vaporization of the current
dipboard. Switch backinto any other program; you're ready
fo paste the retrieved material.
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Tip: To drag highlighted material osfscreen, drag the cursor untilit approaches the too or bottom edge of
the window. The document scrolis automatically; as you approach the destination, jerk the mouse away from
the edge of the window io stop the scrolling.

 
 

Several ofthe built-in Windows XP programsworkwith the drag-and-drop technique,
including WordPad and Outlook Express. Most popular commercial programsof-
fer the drag-and-dropfeature, too, including email programs and word processors,
America Online, Microsoft Office programs, and so on.

 
Asillustrated in Figure 5-5, drag-and-dropis ideal for transferring material between
windows or between programs. It’s especially useful when you've already copied
 

  
  

 
 

 
 

  

Figure 3-5: .. Few people ever expected COKeen ts triamph over the
Click in the middle ofsome Beast; he wastired, sweaty, and missing three of his four | Few people ever capetadO'Reen to trhumph overthe i

Rot slowly, gvadually, he began to focas, pointme [gE

Eo

‘Boast: bi id missing three of his four

 
 
 
 

 
  

oa 2hisone perainag
index Finger toward the lumbering animal “You had my

“wile for hunch,” O"Reea santtered between clenched tecth. }“blow Tr going to have yours.” i

highlighted text (left) and limbs, Hage slowly, seal, to Fens.RTE es Tt The inh arin)

drag it into another place Dl iny ‘wie fee tone” Reen snathered
within the document~into seth.
a different window or

program (right).

ut slowly,

 

 
‘Wow I'm going to have yours” &
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something valuable to your Clipboard, since drag-and-drop doesn’t involve (and
doesn’t erase) the Clipboard.

Its most popular use, however, is rearranging the text in a single document.In,say,
Word or WordPad, you can rearrangeentire sections, paragraphs, sentences, or even
individual letters, just by dragging them—aterrific editing technique. 
 

Tip: Using drag-and-drop to movehighlighted text within a documentalso deletesthetext from its original
location. By pressing Cirl as you drag, however, you make a copy of the highlighted text. 

 

Drag-and-drop to the desktop
Figure 5-6 demonstrates how to drag text or graphics out ofyour document windows
and directly onto the desktop. There your dragged material becomes an icon—a
Scrap file.

 
 

Whenyou drag a clipping from your desktop back into an application window,the
material in that clipping reappears. Drag-and-drop, in other words, is a convenient
and powerful feature;it lets you treat your desktopitself as a giant, computer-wide
pasteboard—an area where you can temporarily stash pieces of text or graphics as
you work.

 
 

Tip: You can drag a Scrap file onto a document's taskbar button, too. Don't release the mouse bution yet.
ina moment, the corresponding document windaw appeers, so that you can continue your dragging opera-
tion until the cursor points to where you want the Scrapfile to appear. Now release the mouse; the Scrap
material appears in the document. 
In Microsoft Office applications, this works with entire documenticons, too. You can drag one Wordfile into
another's window to insert its contents there. 

Figure 5-6:
A Scrapfile will appear

boy Totmat” out when you drag material
shatanrde ern cr EMS Annes nde shall een e out of the documentwin-

* Draaahienovathollandiae These words shall mean the ast * » dow and onto the desktop.
: its icon depends on the

kind ofmaterial contained

within, as shown here at
feft, You can view a clipping
just by double-clicking if, so
thatit opens into its own
window (right).

cants should, however, be aware that only properties containing
cee
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“Insert Object (OLE)
Here’s yet another relative of the Copy and Paste duo: the Insert Object command,

‘which is available—although usually ignored—in many Windows programs. (You
"may hear it referred to as Object Linking and Embedding technology, or OLE, or
= even “oh-LAY”)

~ Using this feature, you can insert material from one OLE-compatible program (like
Paint) into a document runningin another(like Word). Whenyouclick the painting, in
this example, Word’s menuschangeto those ofthe campaign program,so that you can

“edit the graphic. When youclick off the graphic,the familiar Word menusreturn.

Tn general, OLE never becamethe hit that Microsoft hoped, probably because it can
~~ be flaky if you don’t have a fast machine with a lot of memory. Still,if the idea of

- selé-updating inserted material intrigues you,here’s howto tryit:

; 1. Create a documentin a program that offers OLE features.

Some programsthat do: Excel, Word, WordPad, PowerPoint, and Paint.

Click to indicate where you want the inserted object to appear. Choose Insert
Object.

bs

(nsert—>Object is the menu wording in Microsoft Office programs; its location
may differ in other programs.)

Now an Object dialog box appears, offering two tabs: Create New, which creates
anew graph, picture, spreadsheet, or other embedded element: and Create from
File, which imports a documentyou've already created (using, for example, Excel,
Paint, Graph, or Imaging).

If you choose Create from File, a “Link to file” checkbox appears (Figure 5-7). It
determines whether the inserted material will be embedded or (if you turn on the
checkbox) linked. Ifyou chooseto link the inserted material, the fun begins. Now
you can make changes in the original document and watch the revision appear
automatically in any documents to whichit’s been linked.

. Choose the kind of data you want to create, and click OK.7fbb
You've successfully embeddedor linked new information. To edit the document,
just double-click it; the menus andpalettes you need to modify this info reappear.
(if you're linked to a separate document, double-clicking the entbedded object
actually opens that other document.)

_ Export/Import
Whenit comes to transferring large chunks of information from one program to

. another-—-especially address books, spreadsheet cells, and database records—none
of the data-transfer methodsdescribed so far in this chapter do the trick. For these
‘purposes, use the Export and Import commandsfoundin the File menu of almost

-; every database, spreadsheet, email, and address-book program.
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 These Export/Import commandsaren't part of Windows, so the manuals or help
screens of the applications in question should be your source for instructions, For
now, however, the power and convenience of this feature are worth noting: Because
of these commands,your fouryears’ worth of collected names and addressesin,say,
an old address-book program can find its way into a newer program, such as Palm
Desktop, in a matter of minutes.
 

f [Bimap ImageCaResherialiree Chass

a EMicrasaft Graph Chark
:iMterasore PowerPoint Presdntatiol

“EMicrogokt PowerPoint Slide

es the Coblenteofthefleitayour: document andcreates a shorbiut fy Hesource
UBS ie. Chariges: tic he Stree Alewal be rained

 

Filename Extensions

 
Figure 5-7:
Top: You can insert many
kinds of “objects”into
a Word or WordPad
document: a Paintfile

(‘Bitmap image”), image
Document (something
you've scanned), an Excel
spreadsheet (“Work-
sheet"), and so on.

Bottom: You mayprefer to
slap an entire existingfile
into the middle of the one

you're now editing. Do
that using the Create from
File tab. Turn on “Link to

file”ifyou want the data
to updateitself when
the source file is edited

separately.

Every operating system needs a mechanism to associate documentswith the applica-
tions that created them, When you double-click a Microsoft Word documenticon,
for example, Word launches and opens the document.

letters long. Here are some common examples: 
When you double-click this icon ...
Fishing trip.dee
Quarterly results.xls
Home page.htm
Agenda.wpd
A home movieavi

Animation.dir

 
 

In Windows, every document comes complete with a normally invisible filename
extension (or just file extension)—a period followed by a suffix that’s usually three

... this program opensit
Micrasoft Word

Microsoft Excel

Internet Explorer
Corel WordPerfect

Windows Media Player
Macromedia Director
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TipsForan exhaustive list of every file extension on the planet, visit wwwavahatis.com; click the ‘ink for “Every

File Format in the World.”  
Behind the scenes, Windows maintains a massive table that lists every extension and
“the program that “owns”it. To see this list, choose Tools—Folder Options from the
“nent bar of any folder window. When the Folder Options box appears, simply click
the File Types tab (Figure 5-8).

‘Displaying Filename Extensions
“It’s possibleto live a long and happylife without knowing much about these exten-

"Hons. Indeed, becausefile extensions don’t feel very user-friendly, Microsoft designed
“Windows to hide the suffixes on most icons (see Figure 5-9). Ifyou're new to Windows,
and haverrt poked aroundinside the folders on your hard drive much, you may never

"even have seen them.
 

Figure 5-82
Fach software program you installmust register the
fife typesit uses. The link between thefile type and the
program is called an association. This diatog box displays esetere fet
the icon for each file type and an explanation of the SieaniniamAaaa
selectedlisting. In this example. the box tells you that
sound files with the suffix aiff open in Windows Media i AIFF Format Sound
Player when double-clicked, Animated Cursor

ASA File
Windows Media Audio/Wideofile
ASP File

sanRabelAasdiesAfides abeeptbentthae

a)

o> Gatalls for AIPP extension ooo crete re >

| Opens with: {2 Windows Media Player

‘Figs with extension ‘AIFF are of type ‘AIFF Format Sound’. To
change settings that affect all AIFF Format Soundfiles, click
Advanced. : : .

[ Advanced (

Cancel

 
 

<< Some people appreciate the way Windows hides the extensions, because the screen
.. becomesless cluttered andless technical-looking. Others make a good argumentfor

the Windows 3.1 days, when every icon appeared with its suffix.

” For example, in a single Desktop window, suppose one day you discover that three
iconsall seem to have exactly the same name: PieThrower. Only by makingfilename
extensions appear would you discover the answerto the mystery: that is, one of them
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might be called PieThrower.ini, anotheris an Internet-based software updatercalled
PieThrower.upd, and the third is the actual PieThrower program, PieThrower.exe. 
One way to make sense of such situationsis simply to look at the window in De-
tails view (right-click in the window and choose View-+Details from the shortcut
menu).

 
   

-

 
 
  
 
 
 

 
  

 

  

 
Figure $-9;

: Windows fets you see the
Fle. Edit. View’ Favarites File. Edit..View Favorites filename extensions only

when jt doesn’t recognize
them,

& ar Bikansas city Star HTML Document Right: if Windows recog-
MiLicense Agreements, doc ilicense Agreements. Microsoft Word Document nizes ihe filename exter-

Mars Landscape. jog / JPEG Image sion on an icon, it hides
Mildty Amusing Jokes.doc Mildly Amusing Jokes Microsoft Word Cocument the extension (look closely

RaMy Life as a Gnat.dec My Life as a Gnat Microsoft Word Eocumert d at the filenamnes).
Hever Say Cry.mpg Never Say Cry MP3 Format Sound #
New Widgets, ppt LiNew Widgets : Microsoft PowerPoint Presentation Left: You can ask Windows

#8} Popsicle com : epPopsicle.com ot Internet Shortcut to display afl extensions,
EA Quarterly resuts.doc Wi lQuarterly resus 7°. Microsoft Word Document i the ti ‘
BE Salary Projections.cds Bel Salary Projections: : Microsoft Excel Worksheet auine ume.

Shorteut be Funny Quotes Baa Shortcut to Funny Quotes Shortcut
ci Shortcut to Mars Landscape Shortcut to MarsLandscape=Shorteut

 
   

Butthat’s too easy. To fully breathe in Windows technology, you can instruct Windows
to reveal the file suffixes on all icons. To do so, choose Tools—>Folder Options from

any folder window’s menubar. In the Folder Options dialog box, click the View tab.
Turn off “Hide extensions for known file types,” and then click OK.

 
Now the filename extensions for all icons appear.
 

Tip: Evenif you prefer to hide mostfile extensions, you may still want one particular type of documentto
appear on the screenwithfile extensions, For example, when working on a Website, you may wantto check
whether the suffixes of your Web page documents are .Aim or shim!  
In thesesituations, choose Tools—Falder Optionsin any Desktop window.Click the File Types tab (see Figure
5-8). Scroll downto the file extension you want to make visible,click if, click the Advanced button, and~in the
Edit File Type dialog box-turn an “Always show extension.”Click OK, and then click the Close button.  
Hooking up a File Extension to a Different Program
Windows XP comes with several programs (Notepad and WordPad, for example)
that can opentext files with the extension .txt. And Windowsalso comes with several
programs (Paint, Imaging, Internet Explorer) that can open JPEG picturefiles with
the extension .jpg. So how doesit decide which program to open when you double-
click a .txt or jpg file?
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“Windows comes with its own extension-to-application pairing list, as depicted in
‘Figure 5-8. But at any time, you can reassign a particular file type(file extension) to
“a different application. Having just bought Photoshop,fer example, you might want
ittfo open up your JPEG files, rather than WindowsPicture and Fax Viewer.
The long wayto perform this reassignment surgeryis to use the File Types tab of the

“Folder Options dialog box shownin Figure 5-8. Clickthefile type you wantto change,
‘dick the Change button,and then proceed as shown in Figure 5-10.

‘Here’s the short way: Right-click the icon ofthefile that needs a new parent program,
nthe shortcut menu, you'll see a commandcalled Open With. As shown atright in
igure 5-10, it may offer a submenuthatlists the programs capable of opening the

file, If the submenuisn’t offered-—or ifyou bypass these proposals and select Choose
“Program from the subment—Windowspresents the Open With dialog box shown
‘atleft in Figure 5-10. Just find, and double-click, the nameof the program you now
-want to open this kindoffile.

 
 
 

-. Figure 5-90:
~. Left: Windows is prepared
- to show you a list ofevery
"program that can open

.. the mystery file. Scrolf
© through the list ofinstalled
“programsto select the one
* you want. By turning on
. the checkbox at the bottom
“afthe dialog box, you cre-
“ate a file association that

’ will handle similarfiles

~ {those with the samefile
’ extension) in the future.

-. Right: A shortcutto the
> dialog box shown atleft is

- the Open With-Chease
Program shortcul ment.

 
 
 

 

As you do so, be sure to check the status of the checkbox below thelist, which says,
“Always use the selected program to openthis kindoffile.” If that checkbox is on,
then all files of this type(.jpg, for example) will open in the newly selected applica-
tion from now on.If the checkboxis off, then the new application will open only this
Jpg file—just this once.
 

Tip: This techniqueis an effective cureif you've madeafile association by mistake, or when 4 newly installed
program performsthe dreaded Windows Power Grab, claiming a particular file type for itself without asking
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Creating Your Own File Associations
Every now andthen, you might try to open a mystery icon—one whose extensionis
missing, or whose extension Windowsdoesn’t recognize.In thatcase, the dialog box
shown in Figure 5-11 will appear. Maybe you've tried to double-click a document
sent to you by a Macintosh fan (many Macintoshfiles lack file extensions), or maybe
youre opening a document belonging to an old DOS program that doesn’t know
about the Windowsfile-association feature.

In any case, Windowsoffers you two different buttons:

* Select the program fromalist. Windows displays a dialog box that looksa lot like
the oneat right in Figure 5-11. Click the name of the program you want, and then
turn on “Always use the selected program to openthis kindoffile,” if you like.

ne
Figure 5-77:
Left: Sometimes Windows
doesn't know whatto do

with an icon you'vejust
double-clicked:

Right: Use this window
io select a program for
opening the mystery file.
i's sometimes useful to

associate a particular
Senet beplarer document type with a pro-

2} Microsoft Excel gram that didn’t create it
by the way. For example,
if you double-click a text
file, and the Open With
dialog box appears, you
might decide that you
want such documents to

open automatically into
WordPad.

  
° Use the Web serviceto find the appropriate program. In other words, Windows

will take your PC ontothe Internet and look up the mystery file extension on the
Microsoft Website.

Fun with File Associations

The File Types tab on the Folder Options dialog box shownin Figure 5-8 provides
an excellent display of the icons,file extensions, and descriptions of your variousfile
types. As noted earlier, it also offers the New button, which lets you tell Windows
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about new file types, and the Change button,whichlets you reassign an existingfile
se to a different program.

 

\ethe bottom ofthe box, though,is an Advanced button. When you click it, the dialog
box shown at topleft in Figure 5-12 appears. This box contains a few tweaky settings
that could come in handy someday. For example:

Change the icon,Byitself, Windowsdoesn’t let you changethe icon forjust onefile.
But you can change the icon for a particularfile type (JPEG files, for example).

To do so, click Change Icon. Windowsoffers you a handful of replacement icons
for the kind offile youre editing (Figure 5-12, top right). If you don’t see a good
oS one, click Browse. You'll be offered a Change Icon dialog box, which you can use to

navigate to the folder containing a program that maycontain better icons(details
on page 122).

‘Makeit open after downloading. If you turn on “Confirm open after download,”
*. files of this type will automatically open, as though magically double-clicked,

- whenever you download one from the Internet. You might wantto turn this option
: on for compressed file types (.zip, for example), so that they unpack themselves-

automatically. (But avoid turning on this option for file types that may contain
viruses, such as .exe, .vbs, or .bat.)

Change what happens when you double-click it. In the Actionslist, you'll see a
jist of things that might happen when you double-click an icon: open (open) and
printto (print), for example.

Ofcourse, icons almost always open when you double-click them. But by highlight-
“ing one of the other Actions listed here (if, indeed, Windows gives you a choice

© for this file type) and then clicking Set Default, you can establish a new behavior
.. for thefile that you double-click. For example, you might want the JPEGfiles to
“print automatically when double-clicked. (Well, maybe that’s not such a great

~ example.)

* Edit its shortcut menu. When you right-click an icon, Windowsdisplays a short-
“2 cut menu containing commandslike Open, Print, and so on.If youclick the New

=. button, you get the New Action dialog box, where you can add a new command
: to the shortcut menu offiles of this type.

: ¥ou can’t exactly go wild here, adding shortcut-menu commands like Email to
. Uncle Joe, Backdate 30 Days, and so on. In fact, all you canreally do is add com-

_ mands—for example, Open in Photoshop—that open the selected file in a certain
“ program, Figure 5-12 (bottom left) illustrates how it’s done.

: Tip: Placing an ampersand {&) symbel into the shortcut-menu command, as shown at lowerleft in Figure
: 5-12, creates an underlined shortcut key, as shown at lowerright. 
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installing Software
‘Today, almost all new software comes to your PC from one of two sources: a CD or
the Internet. The era of floppy-disk installers is over; you'd need a wheelbarrow to
hold all the floppies required to install the average program these days.

  
Modern software usually comes with an installer program that’s designed to transfer
the softwarefiles to the correct places on your hard drive. The installer also adds the
new program’s nameto the Start-»All Programs menu, tells Windows about the
kindsoffiles(file extensions) it can open, and makescertain changes to your registry
(Appendix C).  
   

Figure 5-82:
Top left: The Advanced box
lets you make even more
decisions about each file
type on your PC, including its
guto-downloading behavior,
double-click behavior, and
(at fop right) evenits icon.  
Bottom left: in the top box,
fype the namefor the new
shoricut-menu command

you wantto create. Then
click Browse to choose the

program file tor Photoshop :
itself, (Alternatively, you i
could type the path to the a
Photoshop program into the
“Application used to perform
action”text box.) Either way,
add a space and then %1
to the end of the pathname
shown in the lower box—a

reference to the file being
opened.

 
 

Open in Paine
‘Gpea in Paintshop

Genesee ight:hoe Bottom right: A doctored
shortcut menu at work.

 
 

 
   

The Pre-Installation Checklist
You can often get away with blindly installing some new program without heeding
the checklist below. But for the healthiest PC and the least time on hold with tech

support, answer these questions before you install anything:

- Are you an administrator? WindowsXP derives partofits security and stability
by handling new software installations with suspicion. For example, you catrt
install most programs unless you have an administrator account (see page 517).
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(‘The exception: You may be able to install new softwareifyou upgraded your PC
from a copy of Windows 2000 on a corporate network, and your account was in
the Power Users group.)

 
If you have only a normal account, most attempts to install new software crash
and burn with some kind of error message.(Ifit’s a relatively new program,the
message might make sense: “To install this program, you must be an administra-
tor or have administrator approval.” Programs that predate Windows XP, on the
other hand, may chug along happily for about a minute before conking out with
some bizarre message of confusion.)

 

Does it run in Windows XP? Windows XPis compatible with far more programs
than Windows 2600 was—but far fewer than, say, Windows 98 or Windows Me.

If the software or its Web site specifically says it’s compatible with Windows XP,
great. Install away. Otherwise, consult the Microsoft Web site, which includes a
list---not a complete one, but a long one—ofall XP-compatible programs. (The
easiest way to get there is to choose Start>Help and Support,then click the “Find
compatible hardware and software for Windows XP”link.) 

: fips See “Older Programs"later in this chapter for compatibility tips. 
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° Is the coast clear? Exit all your open programs. (One quick way: Right-click the
buttons on the taskbar, one at a time, and choose Close from the shortcut menu.)
You should also turn offyour virus-scanning software, which may take the arrival
of your new software the wrong way.

* Am I prepared to backtrack?Ifyou're at all concerned aboutthe health and salety
of the software yowre aboutto install, remember that the Systern Restore feature
(page 475) takes an automatic snapshot of your Windows system just before any
new softwareinstallation.If the new program you've installed turnsoutto be a bit
hostile, you can rewind your system to its current happier working condition,in the
process wiping out every trace of damage(and software) that you've introduced,

installing Software from a CD
Most commercial software these days comes on a CD. On each oneis a program called
Setup, which, on mostinstallation CDs, runs automatically when youinsert the disk
into the machine. You're witnessing the AvtoPlay feature at work.

IfAutoplay is working,a few secondsafter you insert the CD into yourdrive, the hour-
glass cursor appears. A few secondslater, the Welcome screen for your new software
appears, and you may be asked to answer a few onscreen questions (for example,to
specify the folder into which you want the new program installed). Along the way,
the program mayask you to type in a serial number, which is usually on a sticker on
the CD envelope or the registration card,

If the last installer window has a Finish button,click it. The installation program
transfers the softwarefiles to your hard drive. Whenit’s all over, you may beasked to
restart the machine. In any case, openthe Start menu;a yellow “New programs have
been installed” balloon appears next to the All Programs button. If you click there,
the program’s name appears highlighted in orange, and your StartAll Programs
menu is now ready for action.

installing software using “Add or Remove Programs”
Windows XP offers a second, more universal installation method: the greatly im-
proved, butstill ingeniously named, “Add or Remove Programs”program.‘To seeit,
open Start—+Control PanelAdd or Remove Programs.
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As shown in Figure 5-16,thislisting shows every program on your PC—well,at least
those that were installed using a standardWindowsinstaller, Click the nameofone to
expandits “panel,” a thick gray bar that shows you how muchdisk space the program
takes, when you last usedit, and so on.
nn

Flip: Some programs indude a “Click here fer support information” link, which produces a litte window
revealing the name, Website, and sometimes the phone numberof the sofiware companyresponsible for
the software in question. 

 
Use “Add or Remove Programs” whenever the usual auto-starting CD installation
routine doesn’t apply~-for example, when the CD hasn't been programmedfor
AutoPlay, whentheinstaller comes on floppy disks (remember those?}, or when the
installer is somewhereelse on youroffice network.

To make it work, insert the floppy disk or CD that contains the software you want
to install. Then click the Add New Programs buttonat theleft side of the window.
Finally, click the CD or Floppy button to make Windows look around for the Setup
program onthe disk or CD you'veinserted. If the technology gods are smiling, the
installation process now begins, exactly as described above. ,

installing Downloaded Software
The files you download from the Internet (see Figure 5-13) usually aren’t ready-to-
use, double-clickable applications. Instead, almost all of them arrive on your PC in
the form of a compressedfile, with all the software pieces crammed together into a

  

 
Figure §-33-
You can find thousands of Win-
dows programs (demos, free
programs, and shareware) at
Web sites like downloads.com,
tucows.com, oer computingcen-
tral.msn.com.

 
  

 

 

Wouldoil the tooperthe
Top: When you click a link to csi petra
downloadsomething, this box
appears. Click the Save button.

Bottom: Te avoid losing the
downloadin some deeply
nested folder, choase Desktop
from the “Save in:” drop-down
list at the top ofthis box. After
ihe download ts complete, quit
your browser. Unzip the file,
ifnecessary, and then run the
downloaded installer.

 | gg My Docurnents
% Mu Recent Documents

  
iy Ls uments

ce Hy Computer
ofS, 38 Floppy (4)
i Local Disk (C:]
3, CD Drive (:}

Sharad Doni gpents
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Documents
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single, easily downloaded icon. Thefirst step in savoring your downloaded delights
is restoring this compressedfile to its natural state, as described on page 471.

After unzipping the software(if it doesn’t unzipitself), yow'll usually find, among the
resulting pieces, an installer, just like the ones described in the previoussection.

installing Pre-Loaded Software
As you probably know, Microsoft doesn’t actually sell PCs (yet). Therefore, you
bought your machine from a different company, which probably installed Windows
on it before you took delivery.

Many PC companies sweetenthe potbypreinstalling other programs, such as Quicken,
Microsoft Works, Microsoft Office, more games, educational software, and so on. The
great thing about preloaded programsis that they don’t need installing. Just double-
click their desktop icons, or choose their names from the StartAll Programs menu,
and you're off and working.

installing Windows Components
The Windows XPinstaller may have dumpedover a gigabyte of software onto your
hard drive, but it was only warmingup. Plenty of second-tier programsandfeatures
are left behind on the CD—stuff that Microsoft didn’t want to burdenyou with right
off the bat, but included on the CD just in case.

To see the masterlist of software componentsthat you have and haven’t yetinstalled,
choose Start->Control Panel“Add or Remove Programs.” Click the Add/Remove
Windows Components buttonat the left side of the window.

You've just launched the Windows Components Wizard—basically a list of all the
optional Windowssoftware chunks. Checkmarksappear next to someof them;these
are the ones you already have. The checkboxes that aren't turned on are the options
youstill haven’t installed. As you peruse thelist, keep in mind the following:

> To learn what somethingis, click its name once. A description appears below the
list.

» Turn on the checkboxesfor softwarebits you wantto install. Clear the checkboxes
of elements you already have, but that you'd like Windowsto delete in order to
create more free space on your hard drive.

° ‘To the right of the name of each software chunk,you can see how much disk space
ituses whenit’s installed. Keep an eye on the “Space available on disk”statistic at the
bottom ofthe dialog box to make sure you don’t overwhelm your hard drive.

* Windows may ask you te insert your Windows CD.

* Some of these checkboxes’titles are just titles for bigger groups of independent
software chunks (see Figure 5-14),
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As you click the name of a software component, the Details button may spring to
life, “waking up” from its faded look. Whenyouclick it, another list of elements ap-
pears—the ones that make up the software category.

 
 

Figure 3-14:
Most of the optionalinstafla-
tions involve networking and Windows Components
administrative tools designed F ‘You can add or remove coraponents of Windows XP.
for corporate computer
technicians. One in particufar,
however, can be useful to just Lirehoveao
about anybody: Fax Services, “planof the Gainpanerit- idl
This optionalinstallation is the eta
software that turns your PC
into a fax machine. 

anes)

 

The truth is, most people find this list more useful for its ability to remove nones-
sential Windowsfiles (including wallpaper, sounds, screen savers, and so on), saving
multimegabytes of disk space on the process. (Some ideas: the 12 MB of games and
the 13 MB of MSN Explorer {an America Online-like Web browser].) Just turn off
the corresponding checkboxes, click OK, and then restart your machine.

 

Program Access and Defaults
Software is never finished—especially Microsoft’s. That’s why, in the fall of 2002,
Microsoft released a 330 MB software updater called Service Pack 1, whichit later
rolled into Service Pack 2. (See Chapter 10 for details on getting andinstalling Service
Pack 2.)

SP1 didn’t do anything to change XP's looks,features, or speed. It was mostly what
Automatic Update (page 331) had been feeding you all along: bugfixes, securitypatches
for your Internet programs, and so on, Butit also offered a few changeslike these:

 
* Itmade Windowsrecognize USB 2.0,a faster kind of add-on equipment connector

that’s available on new PCs.

* It installed Java (page 356}. 
 

CHAPTER 5: PROGRAMS AND DOCUMENTS

HP Inc. - Exhibit 100 



HP Inc. - Exhibit 1007 - Page 194

: If you make substantial changes to your PC’s guts~-surgery so dramatic that you
have to reactivate XP (page 16)—you now have a three-day grace period before
Windowslocks you out of your own machine. 

 
Thereal raison d’étre for SP1, though, was satisfying the U.S. DepartmentofJustice.
In its agreement, Microsoft promisedto give its competitorsa fighting chanceat equal
footing. Forthefirst time, Windowsoffers you the chanceto hide Internet Explorer,
Outlook Express, and a few other standard Microsoft programs, which is presumably
a benefit to people whoprefer Netscape, Eudora, and Microsoft’s otherrivals.

You can view this new dialog box by choosing Start—-All Programs—>Set Program
Access and Defaults. This commandis actually nothing more thana link to the Add
or Remove Programsicon in the Control Panel—specifically, its new “Set Program
Access and Defaults” panel, whichislisted at the left side. You see the display shown
at top in Figure 5-15, where you can choose from amongthese options:

° MicrosoftWindows means,“Useall ofMicrosoft's utility programs,just as Windows
XP has been doing from Day One.”You're saying that you prefer Microsoft’s Web
browser (Internet Explorer), email program (Outlook Express), Media Player (Win-
dows Media Player), and instant messaging program (Windows Messenger).

 

 
Selecting this option doesn’t prevent you from using other browsers, email pro-
grams, and so on—you'll still find them listed in the StartAll Programs menu.
But this option does put the Internet Explorer and Outlook Express icons, for
example, into prime positions at the upper-left section of your Start menu for
quick and easy access.

Non-Microsoft means, “Use anything but Microsoft’s programs! Instead, use
Netscape Navigator, Eudora, RealPlayer, Sun’s Java, or whatever—just nothing
from Microsoft.”

 
You should install your preferred alternate programs before selecting this option.
Otherwise, the only programsthis feature “sees” are Microsoft programs, which
would make selecting this option a tad pointless.

As with the “Microsoft” option, choosing this option places your preferred pro-
grams’ icons into the upper-left section of your Start menu. Unlike the “Micro-
soft” option, however, this option removes access to the corresponding Microsoft
programs. If you choose a non-Microsoft program as your email program,for
example, Outlook Express disappears completely from the All Programs menu
and its folder (in C:Program Files). Figure 5-15 showsthe idea.

Of course, Microsoft’s programsaren't really gone—they’re just hidden. They pop
right back when you choosethe “Microsoft” option, or when you choose Custom
(described below) and then click the associated “Enable access to this program”
checkbox. lust rememberto click OK to apply your changes.

Computer Manufacturer means, “Use whatever programs are recommended by
Dell” (or whoever made the PC and signed deals with AOL, Real, and so on). This
option doesn’t appear on all PCs.
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> Custom lets you choose each kind of program independently, whether it comes

from Microsoft or not. For example, you can choose Netscape, Internet Explorer, 
or your current Web browser as your default browser.

Figure 5-15:
Top:Justice at work.
Microsoft's settlement
with the U.S. govern-
ment included giving
you the opportunity of
hiding non-Microsoft
programs. Choos-
ing “Non-Microsokt”
completely hides all
traces ofMicresoft’s
Web browser, email
programs, and so on.
They don’t even appear
in the Start menu.

Bottom: Choosing
Custom fets you mix
and match: Microsoit
software for some func-

tions, other companies
for others. 
 

 

A program configuration specifies default orogrems for certain activities, such as Web browsing
- or sending e-mail, and which oragrams are accessible from the Stark ment, deskton, and otherineations.

Choose a configurator:

Dog gS Hon-Micresoft

oO Quckom:

A progran configuration specifies default programe for certain activities, such as Web browsing or sending
email, and which programs ara accessible fram the tiart menu, desktop, and other ineations.

Cheese 3 configuration:

During your selection process, make sure that you've turned on “Enable access
to this program” for each program you want to access (whether or not you're
choosingit as the default program). Otherwise, Windows may deny accessto that
program.
 

Mote: Not ail non-Microseft programs show up here—only versions that have been released since SP1
became avaiable.
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482.

Uninstalling Seltware
Whenyou've had enoughofa certain program, and wantto reclaim the disk spaceit
occupies, don’t just deleteits folder. The typical application installer tosses its soft-
ware componentslike birdseed all over your hard drive; therefore, only someofit is
actually in the program’s folder.

Instead, ditch software you no lenger need using the “Add or Remove Programs”
program described above. Click the Change or Remove Programsbutton at the top
left, and then proceed as shown in Figure 5-16.
 

Fig: $f your computer is a memberof a workgroupandyou're usingFast User Switching (see page 536), don't
delete a program unti! you'veverified thatit isn’t running in somebody else’s account behind the scenes. 

 

ae !
Change or

Remove

~ Wwindawis -.-: 
  

Figure 5-16:
To vaporize a pro-

click i
Currently installed programs: gram, ffs name
cinent inna nenteiinnnnne to revealits gray,

BAA Adobe Acrobet 5.0 highlighted panel, as
Microebrt olfice ¥P Professional’ 00000 osEe shown here, and then

° Clik hs for support information! eS Used clickme Remove bulSee enaa oe Sona oS aecertYT BODR ton. You can use the
Gkcagetaoore Change| “Sort by” drop-down
DSUeee cook. — menu to sort the list by

GI Snaglt 6 Size LL BSB | Frequency of Use or
@> StuffIt 7.0 Size 16,938 Date Last Used. (oie,

:(Ea veware Workstation Stee 14.77MB though, that Windows
g Weather! Size 3.08MB doesn’t keep perfect
ci Windows XP Service Pack 1 track of alf types 8fprograms, especialfy
CD winzip those that run in the
: background, so these

statistics are likely to
be unreliable.)

 
_
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. Even after you uninstall a program,the folder that containedit maystill exist, espe-
“cially if it contains configurationfiles, add-ons, or documentsthat you created while
“> the program was still alive. Ifyowre sure you wor't need those documents,it’s safe to

removethe folder (discussed later in this section), along with thefiles insideit.
 

Hotes Until Service Pack 2 camealong, thelist in this dialog box was cluttered up with dozens upon dozens
“of “Windows Hotfixes”—the little security patches that Microsoft sent out weekly ar monthlyvia theInternet

* just to make yourlife interesting. In SP2, though,they're mercifully hidden—at least until you turn on the
“Show updates” checkboxat the top of the window. Then a new Windows Updates category appearsin the

~ fist, revealing the individual hotfixes you'veinstalledsofar. That's useful to rernemberif you suspect one day
that a certain patch has broken something on your PC. 

“That’s the theory of uninstalling Windows programs, of course. In practice, yowll
.. probably find that the Add or Remove Programs program should more accurately
“be called the “Add or P'll-Make-My-Best-Effort-to-Remove-Programs,-But-No-
“Guarantees” program. A disappointing percentage of the time, one error message or
: another popsup,declaring thatthe installation can’t proceed because Windows can’t

2 find this or that component.
Most of the time, it’s not Windows’s fault. The Add or Remote Programs window
ig simply a list of links, like the All Programssection of your Start Menu. When

ui highlight an entry and click Remove, Windowsjust fires up the program’s own
‘uninstaller program. Whenthe uninstaller doesn’t work, thanks to somebugorglitch,
thefun begins.
The‘truth jis, the world won’t end if you just leave the crippled program on board
yourPC.You can join millionsofother PC fans whoslogalong, hard drives corroded
withbits of software they can’t seem to remove. Apart from the waste of space and the

isyfeeling that your PC is getting cloggedarteries, there’s no harm done.
ou drather wipetheslate clean,start by visiting the Website ofthe companythat

istade:your program.Dig into its supportsection to seeif the company has provided
“any removal instructions. (Some companies discover bugsin their uninstaller

tiesjust like any other part of their programs, andthen release patches—or even
:removal tools—that let their customers remove their software.)

 

 

step doesn’t lead anywhere, you can get serious by eliminating the stubborn
bitsbyhand. Turn off the phone, cancel your appointments for the afternoon, and

oc dlike this:

 

fi that the program can actually be removed.
ay|bethatthe program isn’t really on your hard drive any more, butits or-

hanedlistingiin your Start menulingers on. (For example, maybe you've installed
newerversion of a program that overwrote the older version, or maybe you've
életedtheprogram’s files by hand.) In this case, follow the procedure described
theboxonn page 184 to remove the abandoned entry.
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Tip: lf the program you're trying to remove doesn’t seem to belisted in the Add or Remove Programslist, lock
for otherversionsof the name.Forinstance, te remove Word, look under “M”for Microsoft Wordor Microsoft
Office, {f i?s still not there, open the program's folder in your Start menu and lookfor an Uninstali icon.

2.

a

  

Look for an error message.

When youclick the Removebutton next to a program’s name,do you get an error
message?If so, it’s probably complaining about a missing configurationfile.

Most of the time,thefile that’s missing is the installation log file, a list of the
componentsthat were copied to your hard disk when you originally installed the
software. If the uninstaller can’t find thislogfile, it won’t be able to remove the
software, at which pointit resorts to petty complaining.In thatcase, the besttactic
is to simply reinstall the program, and then try uninstalling again.

If reinstalling still doesn’t work, see the box on the facing page.

. Find out where the pregram is.

As you may know, Windowsprograms’real namesarerarely as friendly asthe names
you see onscreen. To you,it’s StartMicrosoft Word; to Windows,it’s c:\Program
Files\Microsoft Office\Office 1]\WINWORD.EXE.So before you can eliminate a
program,you have to knowits secret location.

Most ofthe time, you can find out the program’s secret location by opening the
Start menu, opening the All Programs menu, andfinding the program'slisting.
Right-click the shortcut, and from the shortcut menu, choose Properties. As you
can see in Figure 5-17, the Target boxtells you the name and folder location of the
culprit. Leave the Properties box open for the moment.

 
2
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 Tarnoff any auto-loading components.  
 

Fartoo many Windows programsare designed to load some of their components
into memory the moment you turn on the PC, where they stay until you shut

: own the machine. The problem is that Windowsrefuses to delete files that are 
 
 

  
 

 
 
 

‘Figure 5-17:
‘As outlined on page 35, the path notation shown here
idetitifies wherethis program sits; each slash indicates
_afolder within folder. The nameafter the final slash
‘identifiesthe actualprogram byffs real name,in this SoanGrap Mareger
‘case:the’ Target box says C:\Pgm Files\PFU|ScanSnap\
Driver\PfuSsMon. exe,

lieve‘Por not PfuSsiMon.exeis the real name ofa
‘programthat appears fo you as ScanSnap Manager.
insteadof trying to rememberall these folder names, Target:

st‘click ihe Find Target button to open a folder window, wen
ete with the program: file highlighted. Start ie

 
  
  
  

 
 

Target ype.=Application

 Target location: Driver

 
 

  
Shortcut key:

© Rar

 

CHAPTER 5: PROGRAMS AND DOCUMENTS : : 4 . . : 4125

HP Inc.- Exhibit 1007~ Page199.



HP Inc. - Exhibit 1007 - Page 200

in use, so you have to close any programsthat are currently running before you
can delete them.

  
Toseeifyour subject has an auto-loadingbit, choose Start—>Run.in the dialog box,
type msconfig and press Enter. (Msconfig is a handy little Windowsutility—not
listed in any menuoravailable in any store—thatlists everything that goes onat
startup time.)

As Figure 5-18 shows, the Startup tab in the resulting dialog boxsts every program
that starts up unbidden when you turn on the PC.Yourjobis to find any pieces
of the program that maybe loading when Windowsstarts, whichisn’t always ob-
yious. The easiest way to do this is to look in the center column, Command, for
the secret folder name you unearthed in step 3, and turn off the checkbox next to
anything that matches.
 

Mofe: Don't go nuts here. Trimmingthefata little doesn't hurt, but this list incudes afew essential Windows
programs that the PC requires to start up. If in doubt, leave it alone. 

 
  Figuare 5-38:

in this example, the recat-
cilrant software bit stuffs

two components into your
of startup process. One of

CHPROGRA~IDIGITAW1DLG, exe . commen stare them, you can identity. CUWINDOWSiinstaller({8CC1 5633-2027-42F4-Ba8S-Bas,.. Commort Stari ie y name (PiuSsSd). The
CAPROGRAM1 \MICROS4|OfFIceLSLOSA,.EXE -b 4 Comireon Startu other, you can identify by

Lo CAPROGRAred COMMON IIMICROS~1WORKSS~i ike... Common Startu | & the path in the Command
#) Quickeys Engine CHPROGRAw\CESOFT~1 \Quickays\QkEnging.exe Common Start. i column (a familiar path).

Snagit 6 CAPROGRAw LLTECHSM~ LYSNAGIT1SnagitaZexe Common Startu :
 

CAPROGRA~ LtScanSoft\MATURA~1Program 
(7) ScanSnap Manager  

... Disable Alb:

   
_

Click OK when you're done.If the PC tells you it must be restarted,click Restart.
Ifyou receive a “You have used the System Configuration Utility” dialog box when
the PC comesto, click OR.

  

If the gods are smiling, you are nowfree to delete the program.
 

5, Look for anything you wantto keep.
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With the programs folder windowstill open from step 3, look for anypersonal files
you want to keep around. In mostcases, thesefiles are in your My Documentsfolder
or on your desktop, and therefore safe from deletion. Butit’s best to makesure. 

 

 
 
 
 

 

 
 
 
 
 
 
 
 

 

 

  

Tape Select View—Details to reveal all the information aboutthefiles in the current folder, and then click
the Date Modified column headerto sort thelisting by date. This way, you can more easily find recently
changedfiles. 

6. Delete the files.

Select all the contents of the program’s folder by pressing Ctrl+A, and then drag
them into your Recycle Bin. Now didr’t thatfeel good? 

Tap: |f Windows Explorer complains that one of thefilesis still in use, just click OK. Then select everything
alse, and keep deleting. If anything remains when you're done, you'll have to force those programsto close
before you can delete them. Right-click an empty area of your taskbar and select Task Manager. Click the

- Processes tab, and look for the remainingfiles in thelist, When you find the file, hightightit and click End
* Process, Finally, try to delete the file once again.

7. Backin the real world, delete the visible scraps of the program from your Start
.. menu and desktop.

. For example, drag any unwantedfiles or folders into your Recycle Bin.

“8, Clean up the mess.

:Yourfinal taskis to find and eliminate anylingeringbits of the stubborn program.
. For instance, if the recently deceased programis still popping up in the Shortcut

-- menus that appear when your right-click certain files, you'll have to update your
- file associations.

Fhe next time you open oneofthe program’s documents, Windowswill complain
= thatit can’t find the program. That’s your opportunity to choose a new program
“to open thosefiles.

: Running Pre-XP Programs
“AsanyWindows2000 usercantell you, stability has its price. For years, people who ran

: Windows 2000 enjoyed far fewer system crashes than Windows Mepeople did-—but
“they werelimitedto a much smaller set of compatible programs, (Barney the Dinosaur
CDs,for example, simply wouldn’t run on Windows 2000.)

though it’s based on Windows 2000, Windows XPisn’t quite as limiting to your
- software library. Microsoft has pulled every trick in the book to make older, pre~-Win-
‘dows XP programs run successfully, For example:

‘16-Bit Programs
A 16-bit program is one that’s so old, it was written when Windows3.1 reamed the
earth and George Bush Sr. was president. (Programs written for Windows 95 and

 

CHAPTER 5: PROGRAMS AND DOCUMENTS : : . _ . 987

HP Inc. - Exhibit 1007 - Page 201



HP Inc. - Exhibit 1007 - Page 202

 
 

. . 188.

later are known as 32-bit programs.) Bit amazingly enough, even Windows XP can
run mostof these programs.It does so ina kind of software simulator—a DO$-and-
Windows 3.1 PC impersonation called a virtual machine.

Asa result, these programs don’t ran veryfast, they don’t understand the longfilenames
of the modern-dayWindows, and they maycrash whenevertheytry to “speak”directly
to certain components of your hardware (the simulator stands in their way, in the
nameofkeeping WindowsXP stable). Furthermore,ifjust one ofyour 16-bit programs
crashes, all of them crash, because theyall live in the same memory bubble.

Even so,it’s impressive that they run atall, ten years later.

DOS Programs
‘These programsare 16-bit programs,too, and therefore they runjustfine in Windows
XP, even though DOSno longer lurks beneath the operating system.

To openthe black, empty DOS windowthat’s familiar to longtime PC users, choose
Start—>All Programs—Accessories—>Command Prompt. (See page 195.)
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rograms Written for Windows95, 2000,Etc.
tn principle, programsthat were written for recent versions of Windows should run
‘fine in Windows XP. Unfortunately, some of them contain software code thatdelib-

rately sniffs aroundto find out what Windowsversion you have. These programs(or
‘eventheir installer programs) may say, Windows what?”--and refuse to run.

 

: ainately, the Properties box of every program (or program shortcut) offers you the
opportunity to foo] such programsinto believing that they're running on a Windows

5 machine, Windows 2000 machine, or whatever. Figure 5-19 details the process,
sta-few footnotes are in order:

 

  
 
 Figure 5-19:

ifyou've successfully installed an olderprogram that

 

 
 

 doesn’t seem to work in Windows XP, findits applica-
tion fcon as described on page 63. Right-click the icon
and choose Properties from the shortcut menu. In the
Properties dialog box, click the Compatibility tab, turn

 

 

 
  
  
 

If vou have problems with this program and it worked correctly on
an earlier version of Windows, select the compatibility mode tat
fhatohes thal earlier version,

 “on “Run this program in compatibility mode for,”and |
then, using the drop-down menuofpast Windows F. Compalitiity mode--—-
versions: choose the version you suspect will make
‘yourprogram happiest. When you click OK, Windows

‘will try to fake out the program, makingit run.
ur dialog box may differ slightly from the one you

see here: depending on the program youare trying
to rites

  
Fun this program in compatibility mode for:

 

 

(1 Runin 640 » 480 screen resolution:

(1 Disable visual themes

ings settings sell tet lee ttt cate ethan

[7] Turnoff advanced text servites forthis program .

ss = iP aa

You remuch better off securing an updated version of the program,if it’s available.
heck the program's Website to see if an XP-compatibility update is available.

trythis trick with utilities like virus checkers, backup programs, CD burning
software, and hard driveutilities. Installing older versions of these with Windows
APisasking fordisaster.

  
 

If t neprogram youre trying to run is on a CD or on a hard drive elsewhere on
the network, you won't be able to changeits properties using the steps described

Figure: 5-19, Instead, choose Start3All Programs—>Accessories>Program
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Compatibility Wizard.A series of wizard screens explains the concept of compat-
ibility-fooling, and then lets you choose the program youd like to fool.  
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4 ven after a fresh installation of Windows XP, a glance at your Start-All Pro-
| grams menu reveals a rich array of preinstalled Windows XP applications—
Jas an infomercial might put it, theyre your free bonus gift. This chapter of-

fers'a crash course in these programs, a few of which could probably merit Missing
fanuals of their own.
 

TheWindows XP Accessories
Microsoft calls many of these built-in programsaccessories. They have two things

useonly occasionally. Second, you get to them from the StartAll Programs—+Ac-
cessories menu.

Accessibility Features
Ifyouhave trouble using your keyboard or making out small text on the screen, the

ogramsin the Start—>All Programs—AccessoriesAccessibility menu may be just
whatyou need.
 

cessibility Wizard
Windows XP is one of the most disability-friendly operating systems on earth. It
includes a longlist of features that enables the PC to magnify, speak, or otherwise

ost the elements of the screen,
 

TheAccessibility Wizard offers these features to you, one feature at a time. Its screens
vite you to enlargeall kinds of things: the type in dialog boxes and menus,scroll
Es and windowborders, desktop icons, the arrow cursoritself, andso on.
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Tip: Not all of these features are useful only to the disabled. If you have a flat-panel screen, for example,
you may have noticed that everything on the screenis smaller thanit might be on a traditional CRT screen.
The result is that the cursor is sometimes hard to find and the text Is sometimes hardto read.

 
 

Finally, the wizard offers specialized accessibility features for the hearing-impaired and
people with trouble using the keyboard.All of these visibility options are duplicated
in Windows XP’s various Control Panel programs (see Chapter 8). Microsoft just
hoped that by putting them all in a single wizard,in interview format, these features
would be easier to find.

Magnifier
Magnifieris like a software magnifying glass—afloating rectangular window that
enlarges whatever your cursor touches (see Figure 6-1). Using the Magnifier Settings
dialog box shown in Figure 6-1, you can specify how much magnification you want
(1 to 9 times), which area of the screen gets magnified, and so on.

On-Screen Keyboard
If you're having trouble typing, keep the On-Screen Keyboard program in mind.It
lets you type just by clicking the mouse(Figure 6-1)—an option you mayfind useful
in a pinch.

Figura 6-¥:
Top: Open Magnifier by
choosing StartAll Pro-
grams—Accessories
Accessibility—Magnifier. You
can drag the large magnified
window (top right) around to
a more convenient spot on

: HS the screen, and even resize it
LCinventcalers: aoe 2 : by dragging the lower-right
£7] St Mievininad : fe? CEDIA bee ; 1 corner. ffyou like, use the

i i : Magnifier Settings dialog box
(top feft) to choose the Invert
Colors option-a color scheme
with higher contrast.

CORB oR ea

Botiom: The On-Screen Key-
board may be just the ticket if
your keyboard keys (or your
hands) aren't fully functional. 
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Narrator

As the little welcomescreentells you, Narrator is a program that reads aloud what-
ever text appears on the screen—-dialog boxes, error messages, menus, text you've
typed, and so on, Narrator doesn’t work in all programs, and it soundsalittle bit
like a Norwegian who’s had a few beers, Still, if you have trouble reading text on
the screen, or if you just like to hear your email read back to you,it’s better than
nothing.

Tip: By closing or moving the Welcomedialog box, you'll discover a second dialog box hiding squarely
behind it-one that lets you control what Narrator reads, and when. For example, you might want to turn
on “Move mouse pointer to the active iter,” so that Windows doesn’t read anything to you until you've
actually pointed to it 

Utility Manager
This strange little program is designed to control the three accessibility programs just
described. Thefirst time you openit, a strange little error message warns you that
someofUtility Manager’s featuresare available only ifyou start and stop the program
using its keyboard shortcut (Windowslogo key+U). That’s good advice.

Once yourein, you'll find the same controls for Magnifier, Narrator, and On-Screen
Keyboard:Start and Stop buttons, plus three checkboxes—one ofwhichlets you start
any of these accessibility programs automatically when you log into Windows XP.

Communications Menu

The Start>All Programs—Accessories—>Communications menu contains several
shortcuts:

* HyperTerminal is an old-time, text-only terminal program-—-the sort people once
used to dial into BBS (bulletin board) systems in the pre-Web era. Even today,
however, you may find this program useful for connecting to telnet systems—the
text-only display system used by many public libraries.

You can also use HyperTerminal to set up a PC-to-PC, modem-to-modem link—a
useful setup when somebody wants to shoota file over to you directly, completely
bypassing the Internet. The mostimportant thing to rememberis that both com-
puters must use precisely the same HyperTerminal settings. (The world is full of
programs that are designed for this kind of file transfer, but this one is free.) If
you yearn for additional details, see “To receive a file from a remote computer”in
HyperTerminal Help.

* Network Connections is a shortcut to the Network Connections program in the
Control Panel, a window that lists every connection you've established to the
internet or to an office network. See Chapter 18 for details.

 

CHAPTER 6: THE FREEBIE SOFTWARE

 

193

HP Inc. - Exhibit 1007 - Page 207



HP Inc. - Exhibit 1007 - Page 208

 

a

* Network Setup Wizard and New Connection Wizard are shortcuts to the setup
programs described in Chapter 18.

* Remote Desktop Connection.As described in the Introduction, one of the differ-
ences between the Professional and Homeeditions of Windows XP is something
called Remote Desktop connection—afeature thatlets you dial into your PC from
the road, bringing to your screen everything youd see if you weresitting in front
of the home PC.

For this to work, only the machine you're dialing inte (the host computer) needs
io be running XP Pro. The PC doing the actual dialing (the client computer) can
be running Windows 95, 98, Me, NT 4.0, 2000 or, of course, XP. Page 622 has the
details.

Entertainment Menu

Thetruth is, you probably wort find the programs in the Entertainment menu par-
ticularly entertaining (unless there’s verylittle going on in yourlife}. A better name for
this menu (Start—>All Programs—Accessories—Entertainment) might be Multimedia,
since all the programsin it relate to video and sound. They're described in Chapter7,
which is, by happy coincidence,called “Pictures, Sounds, and Movies.”

System Tools Menu
This menu (Start—All Programs—Accessories—System Tools) is designed to be a
toolbox for basic Windows administration, maintenance, and troubleshooting pro-

grams. These programs, including Disk Cleanup, Disk Defragmenter, Scheduled Tasks,
System Information, and System Restore,are all described in Chapter 16.

Three of this submenu’s contents, however, have nothing to do with PC health and
fitness, and werestashed here perhaps because Microsoft couldn't find a morelogical
place to stash them, The items in question are Activate Windows, Character Map, and
the Files and Settings Transfer Wizard.

Activate Windows

Few Windows features are more controversial than the activation scheme,a form of

copy protection thatprevents the installation of a single copy of Windows XP onto
more than one PC.

ifyou're not ready to join the Windows XP generation, there's no need to activate your
copy whenthe installer prompts you.In fact, you have 30 days to evaluate Windows
XP and decide whether you want to leave it in place.

During that time, reminder balloons appearat the lower-right corner of your screen
with all the subtlety of a blinking neon sign. Ifyou ultimately decide to activate your
copy, either click that reminder balloonor open thislittle program, which will walk
you throughthe activation process. (Once you've activated your copy, you won't need
this program anymore. Feel free to delete it from your Start menu.)
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Character Map
=> Your computeris capable of creating hundredsofdifferent typographical symbols—
-- the currency symbols for the yen and British pound, diacritical markings for French
and Spanish,various scientific symbols, trademark and copyright signs, and so on.
“Obviously, these symbols don’t appear on your keyboard; to provide enoughkeys,
your keyboard would have to be the width of Wyoming. You can type the symbols,
but they’re hidden behind the keys you dosee.
‘Thetreasure map thatrevealstheir locationsis the Character Map. Whenfirst opening
thisprogram, use the Font drop-down list to specifythe font you want to use (because

ry font contains a different set of symbols), Now yousee every single symbolin
efont. As you hoid your mouse down on each symbol, a magnified version ofit

ppears to help you distinguish them. See Figure 6-2 for details on transferring a
articular symbol to your document.

  

Figure 6-2:
Top: Double-click a character fo transferitto
the“Characters to copy”box, as shown here.
(Double-click several in a row, ifyou wantto  
 

pitirea sequence ofsymbols.) You may have to
scroll down quite a bit in some of today’s modern
Unicodefonts, which contain hundreds of charac-

s. ClickCopy, then Close.
om:| whenyou've returned to your document,

ooseEdit~»Paste to insert the symbols.
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Tae: In general, Internet email can’t handle the fancy kinds of symbols revealed by the Character Map.
Don't be surprised if your copyright symbol turnsinto a gidberish character when received by yourlucky
correspondent.

 
 

Files and Settings Transfer Wizard
This handy utility is designed to simplify the process of moving yourlife from an
older PC to a new one. Page 648 has instructions.

Address Book

The Address Book (Start—All Programs—Accessories-»Address Book)is a central
Windows directory for phone numbers, email addresses, and mailing addresses.

 
Once you've launched the program (see Figure 6-3), choose File-New Contact.
Youre shown a dialog box with seven tabbed panels for various categories of contact
information. Now you're supposedto type the name, email address, phone number,
and other information for each person in your social or business circle. After you've
gone to the troubleof typingin all of this information, Windows XP repays your
efforts primarily in two places: co

+ In Outlock or Outlock Express. As Chapter 12 makes clear, a well-informed ad-
dress book is extremely useful when sending an email message. There’s no need
to rememberthat Harold Higgenbottom’s email address is hhiggenbottom@crawl-
sapce.ix.net.de; instead, you only need to type hhig. The program fills in the email
address for you automatically.

+ In the Search dialog box. As noted in Chapter1,you can quickly look up somebody’s
numberbychoosing Start—Search—>“Printers, computers or people.” (Ifyou're not
part of a corporate domain, the commandsays “Computers or people”instead, )
This function searches your address book and pulis up the requested name and
number.
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Tip: To import address bookinformation from another program, choose File->Import—sAddress Book
(WAB) or FileImport-—Other Address Book. Windows can inhale the information from any of several
popular address bookprograms.  
 

 

 
 
  

  

   
  

  
  
  
  
  
  

   
  

 
 

 
 
 

 
 
 

 
 

Figure 6-3:
Left column: Generally you can
ignore this business of identities, a
system ofseparating the address
books and email collections ef
severalpeople who share the
same PC. The Windows XP user
accounts feature described in
Chapter 17 is a far superior
method ofkeeping everybady’s : sane

= stuffseparate. ene eweieh234@hotmail.com 295-487
225-611

 

Lower right: Right-clicking a name=§ 2 parevecominyour address book produces ie - 225-650
. g shortcut menu that offers such EE Babes
-. useful commands as Send Mail i felarmey, Re Properties ite 225-777

> and Dial. Baca, 30e| Delete 225-616

ate Bachus, a“FindPeople...eats 225-492Baird, Bria. 225-353
Baler, Richard 225-39)ide ath ack eee

 Calculator
Atfirst glance,this calculator (Start~>All Programs—-Accessories-->Calculator) looks

¢ nothing morethan a thinner version of every pocket calculator you've ever seen
Figure 6-4). You can operateit either by clicking the buttons with your mouseor by

pressing the corresponding keys on your keyboard.

Tip: Choosing View~»Digit Groupinginstructs the Calculator to display numbers with commas (123,456,789),

making large numbers (123456789) a lot easier to read, 

ost of the buttonslookjust like the ones on the plastic calculator that’s probably in
out‘desk drawer at this very moment, but several require special explanation:  
 

 

 
: Theslash means “divided by”in computerese,

heasteriskis the multiplication symbol.
Click this button to find the square root of the currently displayed number.

Typeiin one number, click the * button,type a second number,and then click
isbution to calculate what percentage thefirst numberis of the second.
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Yip: This calculator may appearto have almostevery feature you could desire, but, in fact, it lacks a paper-
tape feature—and weall know how easyit is to get iost in the middle of long caiculations.

 

 
The solution is simple: Type your calculation, such as 34+(56/3)+5676+G4"2)=, in a word processor.
Highlightthe calculation you've typed, choose Edit—>Copy, switch to the Calculator, and then choose Edit~
Paste. The previously typed numbers fly into the Caiculatar in sequence, finally producing the grandtotal on
its screen. (You can then use the Edit>Copy commandto copy the result back out of the Calculator, ready
for pasting into another program.)

 
 

But by choosing View—>Scientific, you turn this humble five-function calculatorinto
a full-fledged scientific number cruncher, as shown in Figure 6-4.  

Figure §-8;
After ducking into a phone
booth, the humble Cafcula-

18,026,743.75 | tor (left) emerges as Scientific
Calculator (right), which contains

£2002 [Backspace[ce] oboe. a hexadecimal/decimal/octal/
“baseypomaebag aag Y pis binary converter forprogram-[Lc} z Leta La! me : mers,mathematical functions for

opty onpe pepe panies scientists, and enough other but-
tons to impress almost anyone.
To learn a particular button’s
function, right-click if and choose
What's This? from the shortcut
menu, Don’t miss the online

help, by the way, which reveals
that you can control ever the sci-
entific mode fram the keyboard.
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Command Prompt
© This program summons the MS-DOS window—theblack, empty screen that’s famil-

gar to longtime PC users, At the C:> prompt, you can type any of hundreds of DOS
"=. Commands; when you press Enter, the PC executes your typed instruction.

S You may need to use this DOS modeto run certain older programs that aren’t Win-
~. dows-compatible; masters of DOSalso extolits ability to manipulate (rename, for

example) manyfiles at once, to poke and pred a network (using DOSutilities such
as ping.exe and netstat.exe), and so on.

“. FipsTo leara few of the hundreds of DOS commandsat your disposai, consult the Internet, which is filled
“with excellentlists and explanations. To find them, visit a search page like www.google.com and search for
-” pos commandreference. You'll find numerous ready-to-study Websites thattell you what to typeat the
 MS.005 promot.

= ‘Notepad
ne Notepad is a bargain-basementtext editor, which meansit lets you open, create, and

-» company new programs. You can also use Notepad to write short notes or edit text
_ that you intendto paste into your email program after editingit.

. Notepad basics
“= Notepad opens automatically when you double-click text files (those with the file

- extension .ixt, as described in the previous chapter). You can also open Notepad by
'. choosing StartAll Programs—Accessories—Notepad.

~ You'll quickly discover that Notepad is the world’s mostfrill-free application.Its list
oflimitationsis almost longer than itslist of features.

’ For example, Notepad can’t openlargefiles. If you double-click a text file icon that
' ¢ontains more than about 50 KB of text, Windows XP automatically opensthefile in

WordPad (described next) instead of Notepad. Furthermore, the Notepad window
has no toolbar and can only work with onefile at a time.

 
What’s more, the Print commandon the File menu doesn’t even open the Print dialog
box.Instead,it sendsthefile directly to your printer, so you can’t specify which pages
you want, or how manycopies of them.

Aboveall, Notepadis a text processor, not a word processor. That meansthat you
cant use any formatting at all—nobold,italic, centered text, and so on. That’s not
necessarily bad news, however. The beauty oftext files is that any word processor on
any kind of computer~--Windows, Mac, Unix, whatever—can open plain text files
like the ones Notepad creates.

About word wrap
In the old days, Notepad didn’t automatically wraplinesof text to make everything fit
in its window. As a result, chunks of text often went on foreverin a single line oftext

 

CHAPTER 6: THE FREEBIE SOPTWARE 

.. edit files that contain plain, unformattedtext, like the Read.txt files that often ac- -

 

199

HP Inc. - Exhibit 1007 - Page.213:...:. ‘



HP Inc. - Exhibit 1007 - Page 214

or got chopped off by theright side of the window, which could produce disastrous
results when you weretryingto follow,say, a soufflé recipe. 
In WindowsXP,lines of text wrap automatically, exactly as they do in a word proces-
sor. But you'restill seeing nothing morethan theeffects of the Format—>Word Wrap
command—an option you can turn off, if you like, by choosing the commandagain.
(You can tell when Word Wrapis on bythe presence of a checkmark next to the com-
mand in the Format menu.) 

Tip: When you print from Notepad, the text automatically wrapsto the size of your printer's default paper,
regardless of whether Word Wrap is cn oroff. Choose File->Page Setup from the Notepad menu barto
configure different margins for printing.

Paint

You can use Paintto “paint” simple artwork or to edit graphicsfiles from other sources,
You mightsay that Paint, in other words,is something like Adobe Photoshop (well, in
the same way that you'dsay that the local Cub Scout newsletter is like the New York
Times). Commontasks for this program include making quick sketches, fixing dust
specks on scanned photos, and entertaining kids for hours on end.

Launch Paint by choosing Start—All Programs—Accessories—Paint, and then:

1. Choose Image—Attributesto specify the dimensions of the graphic you want to
create. Click OK.

mG

25 Phi Gs 28/202

ft night Mehnda woke up with a wrrific idea for the newHenraum: Windows for Food Processars! Nate to seth Gat

lossPe afes 2092
lrnar didnt go far the WEF ides, but he countered with
ndows for Digital Alarm Clocka, | thiak hee onta eomething. ¢

And 4/ap2002

‘etve asamibled a team to look inte it bisjor meal Apple's nave
BiCloek. I lhink we ean win thig one] 
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Later in yourlife, you may want to peruse the other commandsin this menu, which
jet you stretch or flip your graphic.

. Click a tool on the paletteat the left side.

If you need help identifying one of these tools, point to it without clicking. A
tooltip identifies the icon by name, while a help message appears at the bottom
of the window.

_ If you've selected a painting tool,like the paintbrush,pencil,or line tool, click a
“paint” color from the palette at the bottom of the window.

You may also want to change the “brush” by choosing from the options located
below the tool palette, like the three spray-paintsplatter sizes shown in Figure
7-5,

. If you've selected oneof the enclosed-shapetools at the bottom ofpalette, right-
click a swatch to specify the color you wanttofill the inside of that shape.

These tools all produce enclosed shapes,like squares and circles. You can specify a
different color for the border of these shapes and forthefill color inside.

. Finally, drag your cursor in the image area (see Figure 6-5).

As you work, don’t forget that you can use the Edit>Undo commandupto three
times in a row, “taking back”the last three painting maneuvers you made. (Just

'  dor’t screw up four times in a row.)

an 2 Forfine detail work,click the magnifying~glass icon and then click your painting.
*» You've just enlargedit so that every dot becomeseasily visible.

: Figure 6-5:
-) The Paint tools include shapes, pens for special uses

-*_ (straight lines and curves), and coloring tools (including an
" airbrush). The top two tools don’t draw anything. instead.

they select portions of the image for cutting, copying. or
dragging to a new location.
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